
Remove any protective plastic film you may find in these areas before using your 
camera:

When playing back pictures on a television or recording them on videotape, ignore 
the steps beginning on page 3-11 of your manual. Instead, do the following:

1 Make sure the camera and TV (and VCR) 
are turned off.

2 Open the camera’s card and port cover 
and connect the black end of the video 
cable to the Video Out port.

3 Connect the yellow end of the cable to the 
VIDEO IN port on the television or VCR.

4 Turn on the TV (and VCR) and switch to 
the correct video mode.

5 Turn on the camera and set the LCD 
monitor switch to PLAYBACK. The most 
recent picture appears on the TV screen.

6 Press the or button to move 
through your pictures.

7 To display or record your pictures as a 
slide show, hold down either the or 

button until you hear two beeps; 
then release the button. The camera now 
scrolls through the pictures.

EPSON is a registered trademark of SEIKO EPSON CORPORATION. PhotoPC is a trademark of 
Epson America, Inc.

Copyright © 1999 by Epson America, Inc. CPD 9386
Long Beach, California, USA 9/99
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Notice to Windows
®

 Users

If you are using the EPSON PhotoPC® 650 TWAIN 
software to delete individual photos within the camera, do 
not attempt to delete locked images. Attempting to do so 
may inadvertently delete other photos. We apologize for 
any inconvenience this may cause.

It is recommended that you first transfer all of your 
images to your computer before you delete photos, to 
safeguard against accidentally deleting the wrong photo.

A new CD-ROM will be available that solves this 
problem. Please contact end user technical support at 
(562) 276-4303 in order to receive an updated disk.

EPSON is a registered trademark of SEIKO EPSON CORPORATION.

PhotoPC is a registered trademark of Epson America, Inc.

Copyright © 1999 by Epson America, Inc. CPD 9349

Torrance, California, USA 8/99
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IMPORTANT NOTICE
DISCLAIMER OF WARRANTY

Epson America makes no representations or warranties, either express or 
implied, by or with respect to anything in this manual, and shall not be liable for 
any implied warranties of merchantability and fitness for a particular purpose or 
for any indirect, special, or consequential damages. Some states do not allow the 
exclusion of incidental or consequential damages, so this exclusion may not 
apply to you.

COPYRIGHT NOTICE
All rights reserved. No part of this publication may be reproduced, stored in a 
retrieval system, or transmitted, in any form or by any means, electronic, 
mechanical, photocopying, recording, or otherwise, without the prior written 
permission of Epson America, Inc. No patent liability is assumed with respect to 
the use of information contained herein. Nor is any liability assumed for 
damages resulting from the use of the information contained herein. Further, 
this publication and features described herein are subject to change without 
notice.

TRADEMARKS
EPSON and EPSON Stylus are registered trademarks of SEIKO EPSON 
CORPORATION.

PhotoPC is a registered trademark and EPSON FaxAdvice is a trademark of 
Epson America, Inc. 

EPSON SoundAdvice is a service mark of Epson America, Inc. 

PictureWorks and HotShots are trademarks of PictureWorks Technology, Inc.
Lexar Media is a trademark of Lexar Media.

General notice: Other product names used herein are for identification purposes 
only and may be trademarks of their respective owners. EPSON disclaims any 
and all rights in those marks.

Copyright © 1999 by Epson America, Inc. CPD 8855
Torrance, California, USA 7/99

A NOTE CONCERNING RESPONSIBLE USE OF 
COPYRIGHTED MATERIALS

Digital cameras and scanners, like photocopiers and conventional cameras, can 
be misused by improper copying of copyrighted material. While some countries’ 
laws permit limited copying in certain circumstances, those circumstances may 
not be as broad as some people assume. EPSON encourages each user to be 
responsible and respectful of the copyright laws when using digital cameras and 
scanners.
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RESAMP3.WMF REMOVED

our new EPSON PhotoPC 650 is an easy-to-use,Y high resolution digital camera with a built-in LCD 
monitor. You can preview your pictures before and after you 
capture them, so you can store only the pictures you want 
before transferring them to your computer. You can even 
display your pictures on a TV or videotape them. 

The PhotoPC 650 captures images at 1152 × 864 pixel 
resolution in 24-bit color, using a 1.09-megapixel CCD 
sensor. You can store approximately 88 pictures with the 
standard 8MB USB CompactFlash™ card and download 
pictures via your computer’s USB port (Windows® 98, 
iMac,™ or Power Macintosh® G3 only) or serial port 
(Windows 95, 98, or PowerPC™ Macintosh). The camera’s 
built-in 37 mm threads let you connect optional video 
camcorder lenses to capture close-up, wide-angle, and 
telephoto shots. 

Introduction
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Your PhotoPC 650 comes complete with cables, batteries, 
USB CompactFlash card, and software for transferring, 
editing, organizing, and printing your pictures. 

EPSON PhotoPC 650 Features

The EPSON PhotoPC 650 is a complete system for 
capturing digital images, and includes the following features:

◗ Resolutions up to 1152 × 864 pixels, ideal for printing 
images up to 5 × 7 inches

◗ 8MB USB CompactFlash card that holds 30 superfine-
resolution, 47 fine-resolution, 88 standard-resolution, or 
4 uncompressed JPEG images (on average)

◗ 24-bit color image capture

◗ 1.8-inch, active matrix TFT color LCD monitor for 
previewing and playing back pictures

◗ Power-saving Quick Review feature for previewing and 
deleting pictures before the camera stores them

◗ Video output for playing your pictures back on a TV or 
for videotaping them

◗ Macro mode for close-ups

◗ Built-in threads for optional 37 mm lenses and filters

◗ Built-in flash with red-eye reduction mode

◗ Automatic shut-off to save battery power

◗ Lexar Media™ JumpShot™ USB cable for transferring 
photos to your USB-compatible Windows 98 PC, iMac, 
or Power Macintosh G3 directly from the USB 
CompactFlash card

◗ Serial cable for transferring photos from your camera 
to your Windows PC or PowerPC™ Macintosh

◗ Video cable for displaying photos on a TV or 
videotaping them

Your camera comes with the following software:

◗ PictureWorks™ HotShots™ software for transferring, 
organizing, editing, and printing your pictures

◗ The EPSON PhotoPC 650 TWAIN driver (Windows) 
or Plug-In (Macintosh) for transferring your pictures
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Optional Accessories

EPSON offers these optional accessories for the 
PhotoPC 650:

◗ AC adapter for use with any electrical outlet (B867038)

◗ NiMH Power Pak with four rechargeable batteries; with 
a universal charger (B818172) or 110V charger 
(B818051)

You can also use optional CompactFlash cards and PCMCIA 
CompactFlash card adapters available from leading suppliers, 
such as Lexar Media or SanDisk. However, only USB-
enabled CompactFlash cards from Lexar Media work with 
the JumpShot USB cable.

You can also attach optional 37 mm video camcorder lenses 
and filters, and connect a tripod to your camera.

See Appendix A for details on using all the optional 
accessories. 

Minimum System Requirements

Make sure your system meets these minimum requirements.

Windows Systems

◗ IBM-compatible PC with 486/66 or higher processor 
(Pentium recommended)

◗ Serial transfer: Microsoft Windows 95, Windows 98, 
or Windows NT 4.0 and an available serial port;
USB transfer: Windows 98 and an available USB port

◗ At least 16MB RAM (32MB recommended)

◗ At least 50MB free hard disk space

◗ Double-speed CD-ROM drive

◗ VGA or SVGA monitor displaying thousands of colors

◗ Mouse or other pointing device

Macintosh Systems

◗ Macintosh with PowerPC or higher processor, iMac, or 
Power Macintosh G3 (see NOTE on next page)

◗ Serial transfer: System 7.6 or higher and an available 
serial port; USB transfer: System 8.1 with iMac Update 
1.0, or System 8.5 or higher and an available USB port 
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NOTE
If your iMac is running OS 8.1, you must install iMac 
Update 1.0 from Apple at http://swupdates.info.apple.com 
before you install the Lexar Media JumpShot USB drivers. 
Contact Apple Computer if you have questions while 
installing this update. 

If your iMac is running OS 8.5, you do not need to install 
iMac Update 1.0. Your operating system already includes full 
support for the Lexar Media JumpShot USB drivers. To find 
out which operating system your iMac is running, select 
About This Computer from the Apple menu.

◗ At least 16MB RAM (32MB recommended)

◗ At least 50MB free hard disk space

◗ Double-speed CD-ROM drive

◗ VGA monitor displaying thousands of colors

◗ Mouse or other pointing device

Registration

Please take a minute to fill out the registration card for the 
PhotoPC 650 digital camera and mail it back to us. This 
enables you to receive special information on accessories, 
new products, and software upgrades. You’ll get immediate 
attention if you have a problem with your PhotoPC 650.

Safety Instructions

Read these instructions and all warnings and instructions 
marked on your camera and batteries before using them.

◗ To reduce the risk of electric shock, don’t remove the 
camera’s cover or open any of the compartments except 
as instructed in this User’s Guide.

◗ To prevent fire or electric shock, don’t insert objects 
through any openings in the camera. Don’t expose the 
camera to rain or moisture.

◗ To prevent fire or explosion, don’t use the camera where 
inflammable or volatile gas is stored.

◗ If the camera shows unusual signs such as noise, odor, or 
smoke, turn it off immediately. Remove the batteries 
and/or disconnect the AC adapter, and unplug the AC 
adapter from the electrical outlet.

◗ To avoid damage to the camera optics, don’t expose the 
lens to direct sunlight for extended periods of time.

◗ Don’t use the camera outdoors during adverse weather 
conditions.

◗ Don’t store the camera near sources of bright light, 
direct sunlight, high humidity, heat, excessive dirt or 
dust, or where it will be exposed to strong vibrations or 
magnetic fields.
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◗ To prevent possible eye injury, don’t take flash pictures 
of faces at close range.

◗ Avoid sudden temperature changes, which can cause 
moisture to condense on the camera. Keep the camera in 
a case or bag if you need to move it from a cold 
environment to a warm one. Allow time for the camera 
and its optional accessories to adjust to temperature 
changes before using them.

◗ Don’t use a frayed or damaged power cord with the 
AC adapter.

◗ To ensure the best performance, make sure the AC 
adapter is fully plugged into the camera whenever you 
connect it. 

◗ Remove batteries and/or unplug the camera and the AC 
adapter and refer servicing to qualified service personnel 
under the following conditions: if the power cord or 
plug is damaged; if liquid has entered the camera; if the 
camera has been dropped or its exterior has been 
damaged; if the camera or its accessories do not operate 
normally or exhibit a distinct change in performance.

◗ Adjust only those controls that are covered by the 
operating instructions.

◗ Don’t attempt to service the camera yourself. Refer all 
servicing to qualified service personnel.

◗ If the liquid crystal solution contained in the status 
display panel or in the LCD monitor leaks out and gets 
on your hands, wash them thoroughly with soap and 
water. If it gets in your eyes, flush them immediately 
with water.
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USB CompactFlash card 
in envelope

JumpShot 
USB cable

his chapter helps you get ready to use your new TPhotoPC 650. It covers the following:

◗ Unpacking your PhotoPC 650

◗ Installing the USB CompactFlash card

◗ Installing and using batteries

◗ Attaching the hand strap

◗ Removing the protective plastic

◗ Setting the date and time

◗ Formatting the USB CompactFlash card

◗ Installing your PhotoPC 650 software

◗ Identifying camera parts

Getting Started
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Unpacking Your PhotoPC 650

Make sure you have all the parts shown on the previous page. 
You won’t need the Macintosh adapter cable with a PC, or 
the JumpShot USB cable, if you don’t have a Windows 98, 
iMac, or Power Macintosh G3 system with compatible USB 
support. However, you must install the USB CompactFlash 
card to provide memory for your camera. It’s in the 
envelope labelled “ATTENTION!”.

Installing the CompactFlash Card

Follow these steps to install the USB CompactFlash card:

1 Before you start, make sure the camera is turned off. The 
lens cover switch should be in the off position.

2 Remove the USB CompactFlash card from the envelope 
labelled “ATTENTION!”.

3 Open the camera’s card and port cover and insert the 
card all the way into the slot, as shown below. Make sure 
the card’s label faces the front of the camera.

4 Close the card and port cover. 

EPSON

EPSON

lens cover switch 
down: Off

CARD
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Installing Batteries

Before you install the four AA alkaline batteries that came 
with your camera, make sure the camera is turned off (the 
lens cover switch is in the off position, as shown to the left). 
Then follow these steps:

1 Turn the camera upside down with the front of the 
camera facing you. 

2 Push the battery cover down and to the right. Then raise 
the cover.

 

3 Insert all four batteries into the compartment, 
positioning the + and – ends as shown:

4 Close the battery cover by sliding it to the left while 
pressing it down until it snaps into place.

See the next page for important information about using 
your batteries safely and efficiently.

+ end

– end
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Using Batteries Safely and Efficiently

When your batteries need to be replaced, the PhotoPC 650 
camera can accept four AA batteries of the following types:

◗ Rechargeable NiMH batteries (recommended)

◗ Rechargeable NiCad batteries

◗ Single-use alkaline batteries

◗ Single-use lithium batteries (longer life)

WARNING
To avoid the danger of fire or explosion, do not mix different 
types of batteries. Do not allow the battery contacts to touch 
metal objects such as coins or keys, which could short out the 
battery’s circuits. Read all safety and handling instructions before 
using batteries.

EPSON offers an optional NiMH Power Pak that includes a 
charger and rechargeable batteries for convenient battery 
replacement whenever you need them. When you’re 
transferring pictures to your computer with the serial cable, 
you’ll use more battery power, so it’s best to power your 
camera with the optional AC adapter. See page A-2 for 
details on EPSON’s optional power accessories.

TIP
To save battery power, use the camera’s View mode sparingly. 
You can still view pictures before saving them with the Quick 
Review feature; see Chapter 2 for details.

Note the following as you use batteries:

◗ Don’t use manganese batteries.

◗ Replace all four batteries at the same time. Don’t mix 
old and new batteries.

◗ Don’t drop, puncture, disassemble, or mutilate batteries. 
Don’t get them wet or expose them to fire.

◗ When the camera isn’t used for long periods of time, 
remove the batteries and store them at a low temperature 
in a dry location. Store away from the reach of children.

◗ To avoid fire or electric shock, don’t use batteries that 
are leaking or damaged in any way.

◗ If battery acid gets in your eyes or on your skin, 
immediately rinse the area with water and seek medical 
treatment. If a battery is swallowed, seek medical 
treatment immediately.
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◗ Dispose of used batteries according to the 
manufacturer’s instructions and in compliance with all 
applicable laws. Contact your local government agency 
for information about battery recycling and disposal.

◗ Battery life varies depending on the battery type, the 
manufacturer, and other factors.

◗ Avoid using your camera in low temperatures, especially 
below 50 °F (10 °C); this drains your batteries faster. 

Attaching the Hand Strap

To attach the hand strap, slide the loop through the holder 
on the camera, then pull the strap through the loop.
.

Removing the Protective Plastic

You may need to peel off protective plastic sheets from your 
camera’s back panel, the status display panel at the top of the 
camera, and the viewfinder area on the front of the camera.

Setting the Date and Time

Before you use the camera, you need to set its clock. Then 
the camera will automatically record the date and time for 
each picture you take. You’ll need to set the clock again 
whenever you install new batteries.

Follow these steps to set the camera’s clock:

1 Slide the lens cover switch up to the ON position to 
open the lens cover and turn on the camera.

EPSON

EPSON

lens cover switch 
up: ON
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NOTE
If you hear rapid beeps and see an error on the status display 
panel on the top of the camera when you first turn it on, you 
may not have installed the USB CompactFlash card or may 
have installed it incorrectly. Follow the steps on page 1-2 to 
install the card and try again. If you still get an error, see 
Chapter 9 for troubleshooting information.

2 On the back of the camera, slide the monitor switch to 
PLAYBACK. You see a message asking you to set the 
clock.

3 Press the SELECT button. You see the clock setting 
display in the LCD monitor, with the month setting 
highlighted in white:

4 If necessary, press the  button to increase the 
number or the  button to decrease the number, 
until the month is correct.

5 Press the SELECT button. The month setting is saved 
and the day setting is highlighted.

6 Adjust the day, year, hour, and minute settings as 
described above until the date and time are correctly 
adjusted and saved.

After you finish setting the clock and press the SELECT 
button, your monitor returns to playback mode. 

7 Slide the monitor switch to the OFF position.

monitor 
switch

SELECT 
button

Clock Setting

05/15/99
02:37

mm/dd/yy
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Formatting the USB CompactFlash 

Card

Before you use your camera for the first time, you need to 
format your USB CompactFlash card so it can store your 
pictures. After that, you only need to format the card if a 
message appears on the LCD monitor instructing you to do 
so or if you want to quickly erase all the pictures it contains.

Make sure you installed the USB CompactFlash card in the 
camera (as described on page 1-2), and set the camera’s date 
and time (as described on page 1-5), then follow these steps:

1 On the back of the camera, set the monitor switch to 
PLAYBACK (as shown to the left). 

2 Press the SELECT button to display the LCD monitor 
menus.

3 Press the  or  button until you see the Photo 
Control menu. Then press the SELECT button to 
display the menu options, as shown below:

4 Press the  or  button until Reformat is 
highlighted, then press the SELECT button. A warning 
message appears. 

5 Press the SELECT button again to format the card and 
return to the Photo Control menu.

6 Press BACK until you return to normal playback mode.

NOTE
Your USB CompactFlash card works with any ATA-compatible 
digital camera, such as EPSON’s PhotoPC 600, 700, or 750Z 
cameras.

If you have problems formatting or using your CompactFlash 
card, contact Lexar Media, as described on page 9-10.

Photo Control

Erase 

Lock

Reformat
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Installing Your PhotoPC 650 Software

Your PhotoPC 650 comes with everything you need to 
transfer your pictures from the camera to your computer, 
and organize, enhance, and print your images. The 
CD-ROM has these applications for your PC or Macintosh: 

◗ PictureWorks HotShots

◗ EPSON PhotoPC 650 TWAIN driver (Windows) or 
Plug-In driver (Macintosh)

It also contains the driver software for the JumpShot USB 
cable and USB CompactFlash card, which you need to install 
only if you’re using a compatible USB system. If you’re using 
a Macintosh, you’ll install the USB drivers along with your 
other camera software. Installation of the Windows 98 USB 
drivers is covered in Chapter 4.

Installing on a Windows PC

Close all open applications, then follow these steps:

1 Insert the EPSON CD-ROM in your drive. 

2 Double-click My Computer. Then double-click your 
PhotoPC 650 CD-ROM icon. 

3 Double-click the Setup.exe icon. The installer opens.

4 Follow the instructions on the screen to install HotShots 
and EPSON PhotoPC 650 TWAIN. Be sure to select 
Full Install on the Setup Options screen.

Installing on a Macintosh

Close all open applications, then follow these steps:

1 Insert the EPSON CD-ROM in your drive. 

2 Double-click the PhotoPC 650 CD-ROM icon on your 
desktop to open the CD-ROM window, if necessary. 

3 Double-click the HotShots Installer icon to install 
HotShots and the EPSON PhotoPC 650 Plug-In driver. 
Click Continue and follow the on-screen instructions.

4 If you’re using an iMac or a Power Macintosh G3, you 
also need to install the drivers for the JumpShot USB 
cable and USB CompactFlash card. 

Double-click the Lexar Media JumpShot folder to 
open it, then double-click the Lexar Media 
JumpShot Installer icon. Follow the on-screen 
instructions to view the license agreement and Read Me 
file, and install the drivers. At the end of installation, 
click Restart to restart your system.
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Identifying Camera Parts

EPSON

EPSON

viewfinder

timer light

front view

shutter button
flash

lens lens cover 
(on/off)

card and 
port cover

37 mm threads 
for optional 
lenses bottom view

tripod threads

battery cover CompactFlash 
card eject switch



1-10   Getting Started

LCD monitor 
switch

status display 
panel

viewfinder

back view

LCD monitor

status light

FUNCTION 
button

EPSON

top view

shutter 
button

image 
quality 
button
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flash 
button

macro/timer 
button
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Jim Jackson’s Auto Sales

• 1995 Mitsubishi Montero

• Good condition

• Low Mileage

FOR SALEFOR SALE

999-555-5555

aking pictures with PhotoPC 650 is similar to using Ta traditional “point and shoot” auto-focus camera. 
This chapter tells you everything you need to know about 
getting great shots, including the following information:

◗ Getting ready to take pictures

◗ Taking pictures with the viewfinder or LCD monitor

◗ Checking the picture counter

◗ Setting image quality

◗ Using macro mode to take close-ups

◗ Using the flash and timer

Getting Ready to Take Pictures

Before you can take pictures with PhotoPC 650, you need 
to turn on the camera and check the status of your batteries 
on the status display panel. 

Taking Pictures 
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Turning the Camera On and Off

To turn on the camera, slide the lens cover switch to the ON 
position, as shown in the illustration below. The lens cover 
opens and the status display panel on the top of the camera 
lights up. The status light on the back of the camera flashes 
for a few seconds (if the LCD monitor switch is set to 
PLAYBACK, set it to VIEW or OFF to take pictures). When 
it turns green and stays on, you can take pictures.

To turn off the camera, slide down the lens cover switch to 
the off position. The lens cover closes, and the status display 
panel and status light turn off.
.

Saving Battery Power with Auto Shut-off

When the LCD monitor is turned off and you wait more 
than 60 seconds before or after taking a picture, the camera 
shuts off automatically to save battery power.

When the LCD monitor is on, the camera shuts off if you 
wait more than 30 seconds before or after taking a picture.

To “wake” the camera after auto shut-off, press the SELECT 
or BACK button on the back of the camera, or use the lens 
cover switch to turn the camera off and on again.

Using the Status Display Panel

The status display panel shows the current camera settings 
and the status of your battery power:
.

EPSON

EPSON

status display 
panel

lens cover switch 
down: OFF

lens cover switch 
up: ON

timer

pictures 
remaining

image quality

flash mode macro 
mode 

battery power

video mode

red eye 
reduction flash
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Checking the Battery

When your battery power is running low, the low 
battery icon appears on the status display panel. The icon 
flashes when your battery power is completely out. 

You need to replace the batteries or use the AC adapter when 
you see the low battery icon. Although you may be able to 
use the camera with low batteries, it may operate differently. 
The camera needs full battery power to operate reliably.

NOTE
The low battery icon estimates remaining battery power. 
You may have some power left even when the low battery icon 
appears, depending on the type of batteries you’re using. When 
you see the icon, try turning the camera off (as described on the 
previous page) and letting the batteries “rest” for a minute or 
two. Then turn the camera back on and try to take more pictures.

Many factors can affect battery life, including the 
surrounding temperature. See page 1-3 for battery handling 
and power-saving details.

Picture-Taking Guidelines

To take the best pictures, follow these guidelines:

◗ Make sure your subject and the camera aren’t moving, 
or your picture will be blurred.

◗ When you auto-focus your picture (by pressing the 
shutter button halfway down), position the most 
important subject in the center. This sets the camera’s 
focus point based on the distance from the camera to the 
center subject. Objects in the foreground or background 
of the focus point won’t be focused as sharply. Once 
you’ve auto-focused, you can move the camera so the 
most important subject is slightly off center, if you want.

◗ Remember that room lighting affects the color casts that 
appear in your picture. Certain lighting—such as by 
fluorescent, incandescent, and halogen lamps—can add 
a green or yellow cast. You can touch up pictures taken 
in these lighting conditions using HotShots; see 
Chapter 7 for instructions.

◗ In certain low light conditions—such as evening, 
outdoor scenery shots where the subject is over 9 feet 
away—you may get the best results by disabling the 
camera’s flash, using the timer feature, and either 
holding the camera steady or placing it on a tripod, as 
described in this chapter.
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Taking Pictures with the Viewfinder

You can capture an image with the PhotoPC 650 as you 
would with any point-and-shoot auto-focus camera: look 
through the viewfinder and snap the two-step shutter. 
However, you can also use the LCD monitor to preview your 
picture as you take it; see page 2-6 for instructions. 

Follow these steps to take a picture with the viewfinder:

1 Make sure you are at least 12 inches (0.3 m) away from 
your subject. (If you want to get closer, use macro mode 
as described on page 2-10.)

2 Turn the camera on and wait until the status light turns 
green and stays on.

3 Look straight through the viewfinder and center your 
subject within it.

NOTE
For best results, use the LCD monitor to take macro mode 
pictures; see page 2-10 for instructions. If you use the 
viewfinder for macro or close-up pictures, you’ll need to 
allow space around the image to compensate for any 
parallax shift (the difference between what you see in the 
viewfinder and the captured image).

4 Hold the shutter button halfway down to lock the auto 
focus. You hear a click and the status light changes from 
green to orange. While holding the shutter button 
down, you can reframe your picture and move your 
subject off-center if you want. 

5 Press the shutter button the rest of the way down to take 
the picture.

6 Hold the camera still until it beeps and the status light 
starts flashing red. The flashing red light indicates that 
the camera has captured the image and is processing it. 

shutter 
button

status 
light

viewfinder
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CAUTION
If you set the camera down while the light is still flashing, 
make sure you handle it carefully. The camera may lose your 
image if you set it down too hard. 

7 Then move the camera away from your eye and check 
the Quick Review image on the LCD monitor. (If you 
don’t see the image, Quick Review mode may be turned 
off; see page 3-14 to turn it on.)

The Quick Review image lets you see how your picture 
will turn out and lets you delete the picture, if necessary, 
before your camera saves it. (You can still delete the 
picture after it’s saved.)

The Quick Review image remains on the monitor for 
around 5 seconds. A gauge on the image shows you the 
time you have left to delete the picture before it’s saved. 
To delete the picture, hold down the FUNCTION 
button and press the BACK button.

If you didn’t delete the image before the Quick Review gauge 
disappeared, the image is saved when the status light stops 
flashing and turns green. You can take another picture at this 
point. Saved images remain in memory for at least a year, 
even when the camera is off and the batteries are removed.

NOTE
Remember that the camera shuts off automatically 60 seconds 
after you take a picture with the LCD monitor turned off. To 
“wake up” the camera, press the SELECT or BACK button on 
the back of the camera or use the lens cover switch to turn the 
camera off and on again.

Quick Review gauge
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Taking Pictures with the LCD Monitor

The LCD monitor lets you see a live preview of what the 
camera’s lens sees at any moment. Note the following when 
taking pictures with the LCD monitor:

◗ The image area displayed on the LCD monitor is 
slightly smaller than the image that will be captured.

◗ In direct sunlight, you may need to shade the LCD 
monitor with your hand to see it better, or you can 
adjust the LCD brightness setting to make viewing 
easier (see page 3-14 for instructions).

◗ In a low lighting environment, the image on the LCD 
monitor may appear speckled or “noisy” due to 
insufficient light reaching the camera’s sensor. This 
won’t affect the quality of your picture unless you turn 
the flash off. (See page 2-11 for instructions on using the 
flash.)

◗ The preview image may appear to flicker under strong 
fluorescent lighting. When your subject is very bright (a 
sunlit white wall, for example), you may see a band of 
washed-out color in the image on the monitor. This will 
not affect the actual image captured by the camera.

Follow these steps to take a picture with the LCD monitor:

1 Turn on the camera and slide the monitor switch left to 
the VIEW position. You see a preview of your picture on 
the LCD monitor.

2 Center your subject on the monitor and hold the shutter 
button halfway down to lock the auto focus. 

You hear a click and the status light changes from green 
to orange. While holding the shutter button down, you 
can reframe your picture and move your subject off-
center if you want. 

monitor switch
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3 Press the shutter button the rest of the way down to take 
the picture.

4 Hold the camera still until it beeps and the status light 
starts flashing red. The flashing red light indicates that 
the camera has captured the image and is processing it. 

CAUTION
If you set the camera down while the light is still flashing, 
make sure you handle it carefully. The camera may lose your 
image if you set it down too hard. 

5 The Quick Review image appears on the LCD monitor. 
(If you don’t see the image, Quick Review mode may be 
turned off; see page 3-14 to turn it on.)

The Quick Review image lets you see how your picture 
will turn out and lets you delete the picture, if necessary, 
before your camera saves it. (You can still delete the 
picture after it’s saved.)

The Quick Review image remains on the monitor for 
around 5 seconds. A gauge on the image shows you the 
time you have left to delete the picture before it’s saved. 
To delete the picture, hold down the FUNCTION 
button and press the BACK button.

If you didn’t delete the image before the Quick Review gauge 
disappeared, the image is saved when the status light stops 
flashing and turns green. You can take another picture at this 
point. Saved images remain in memory for at least a year, 
even when the camera is turned off and the batteries are 
removed.

NOTE
The LCD monitor uses up battery power quickly. If it is idle for 
more than 30 seconds, the camera shuts off automatically. To 
“wake up” the camera, press the SELECT or BACK button on 
the back of the camera or use the lens cover switch to turn the 
camera off and on again.

Quick Review gauge
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Checking the Picture Counter

The number in the upper right corner of the status display 
panel shows how many pictures you can take, depending on 
your current image quality and format settings. If you change 
these settings, the number may also change.

When the camera’s memory is full, the number of pictures 
remaining is 0. The status light on the back of the camera 
turns red, and you hear a rapid beeping when you press the 
shutter button. 

To free up some of the camera’s memory, you can play back 
your pictures on the LCD monitor and erase the ones you 
don’t want to save; see page 3-2 for instructions. If you want 
to save your pictures before you erase them, you need to 
transfer the images to your computer, as described in 
Chapter 4.

Setting Image Quality

The PhotoPC 650 has four image quality (resolution) 
settings. Press the image quality button on top of the 
camera to cycle from one setting to the other.

The PhotoPC 650 image quality settings vary by the number 
of pixels and level of compression used to store the picture. 

Pixels (picture elements) are the tiny “dots” of color or tone 
that make up the image. Your eye blends the pixels together 
so they appear as continuous tones; the more pixels in an 
image, the sharper the image appears.

pictures remaining

EPSON

image quality button
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Compression is a technique used to make the image data fit 
in a smaller memory area and transfer at a quicker rate. The 
JPEG compression used by your camera eliminates some 
image data (“lossy” compression) to achieve these results. 
The Uncompressed image quality setting doesn’t 
eliminate image data (“lossless” compression), but the images 
are much larger and slower to transfer.

You can select from these image quality settings:

Fine

Produces color images at 1152 × 864 pixels, with 
moderate compression. Your pictures include ample 

detail, and the CompactFlash card holds approximately 
47 pictures.

Superfine 

Produces color images at 1152 × 864 pixels with 
low compression. Your pictures include greater 

detail, and the CompactFlash card holds approximately 
30 pictures. With less compression, superfine images are 
better for enlarging. 

Standard

Produces color images at 640 × 480 pixels. The 
CompactFlash card holds approximately 

88 pictures, but the image size is smaller and includes less 
detail when enlarged. You should use this setting when 
taking lower resolution pictures for distribution on the 
World Wide Web.

Uncompressed

Produces color images at 1152 × 864 pixels with 
lossless compression. The CompactFlash card holds 
approximately 4 pictures in this mode. It’s best to 

use this mode only for specialty applications that require 
uncompressed pictures. 

Fine image quality is sufficient for most purposes. Use 
superfine if you need maximum detail (in enlargements, for 
example), but remember that the image files are larger than 
fine quality image files and take longer for the camera to 
process.

NOTE
You can switch freely between the settings and mix pictures of 
varying quality in the camera. The camera’s picture capacity will 
vary accordingly. Depending on the content of your pictures, your 
camera may hold more or fewer pictures than listed here.



2-10   Taking Pictures

Using Macro Mode to Take Close-ups

You can use the camera’s macro mode to take pictures as 
close as 6 inches (15 cm). Follow these steps:

1 Turn the camera on and slide the monitor switch to the 
VIEW position. You see a live preview on the LCD 
monitor.

2 Press the /  macro button on top of the camera 
once. The  macro icon appears on the status display 
panel. 

3 Press the shutter button halfway down to focus, then 
press it all the way down to capture the image.

4 Hold the camera still until it beeps and the status light 
starts flashing red. The flashing red light indicates that 
the camera has captured the image and is processing it. 

CAUTION
If you set the camera down while the light is still flashing, 
make sure you handle it carefully. The camera may lose your 
image if you set it down too hard. 

5 The Quick Review image appears on the LCD monitor. 
(If you don’t see the image, Quick Review mode may be 
turned off; see page 3-14 to turn it on.) This lets you see 
how your picture will turn out and lets you delete the 
picture, if necessary, before your camera saves it. (You 
can still delete the picture after it’s saved.) 

The Quick Review image remains on the monitor for 
around 5 seconds. A gauge on the image shows you the 
time you have left to delete the picture before it’s saved. 

EPSON

macro button Quick Review gauge
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To delete the picture, hold down the FUNCTION 
button and press the BACK button.

If you didn’t delete the image before the Quick Review 
gauge disappeared, the image is saved when the status 
light stops flashing and turns green. (You can still delete 
the picture after it’s saved, if necessary.)

To turn off macro mode, press the /  macro button 
three times or turn off the camera. The camera returns to 
normal photo mode automatically.

NOTE
To take macro close-ups in low light conditions, use a tripod and 
the timer (see page 2-12), and disable the flash (as described in 
the next section). Otherwise, your pictures may appear blurry and 
washed-out.

Using the Flash

The camera’s built-in flash is effective within a range of 3.2 
to 9.8 feet (1 to 3 m). Press the flash button to cycle 
through the four flash settings. 

An icon for each setting appears on the status display panel:

Auto

The flash goes off automatically whenever it’s needed 
for adequate lighting (factory setting). Use only when 
you’re 3.2 to 9.8 feet (1 to 3 m) from your subject.

Forced Flash

The flash goes off with every picture you take. Use 
this setting to compensate for backlighting; for 
example, when you are facing a light source.

Flash Off

The flash is disabled. Use this setting for special 
effects, where flash photography is prohibited, or for 
macro mode close-ups.

Red-Eye Reduction Flash

The flash blinks on and off rapidly, then flashes 
normally to prevent light from shining directly off 
your subject’s pupils. Use this setting for flash 
pictures of people or animals.

Your flash setting remains in effect even after you turn off the 
camera. 
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Taking Pictures with the Timer

Setting the timer creates a 10-second delay between the time 
you press the shutter button and the actual image capture. 
This allows you to take a picture of yourself. 

Follow these steps to take a picture with the timer:

1 Place the camera on a flat surface or install it on a tripod. 
(See page A-3 for tripod instructions.)

2 Turn on the camera and wait until the status light turns 
green.

3 Press the /  timer button twice. The timer icon 
appears on the status display panel. If you’re taking a 
timed, macro mode picture, press the /  timer 
button three times. The timer and  macro icon 
appear on the status display panel.

4 Press the shutter button. The red timer light on the 
front of the camera comes on and the timer icon on 
the status display panel begins flashing. About 2 seconds 
before the camera takes the picture, the red timer light 
flashes.

The camera beeps when the image is captured and the 
status light flashes red.

5 The Quick Review image appears on the LCD monitor 
on the back of the camera to let you see how your 
picture will turn out and let you delete the picture, if 
necessary, before your camera saves it. (If you don’t see 
the image, Quick Review mode may be turned off; see 
page 3-14 to turn it on.)

The Quick Review image remains on the monitor for 
around 5 seconds. A gauge on the image shows you the 
time you have left to delete the picture before it’s saved. 
To delete the picture, hold down the FUNCTION 
button and press the BACK button.

If you didn’t delete the image before the Quick Review 
gauge disappeared, the image is saved when the status 
light stops flashing and turns green.

6 Once you’ve taken a timed picture, the camera turns off 
the timer automatically. To take another picture with 
the timer, repeat steps 3 through 5.

Quick Review gauge
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he LCD monitor lets you play back your pictures Tone-by-one or in groups of nine at a time. You can 
erase selected pictures and customize camera settings 
through the LCD monitor menus. You can even view your 
pictures on a television just as easily as on the camera’s 
monitor. This chapter explains the following:

◗ Using playback mode menus

◗ Playing back pictures one by one

◗ Playing back multiple pictures

◗ Playing pictures as a slide show

◗ Turning off picture information

◗ Erasing and locking pictures

◗ Playing back pictures on a TV

◗ Changing the camera settings

◗ Setting the language of the playback mode menus

Playing Back Pictures
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Using Playback Mode Menus

Follow these steps to use the playback mode menus:

1 Turn on the camera, as described on page 2-2.

2 Slide the monitor switch to PLAYBACK. After a 
moment, the last photo you took appears on the LCD 
monitor.

3 To access the menus, press the SELECT button. 

Blue menu icons appear at the top of the monitor with 
the currently selected menu highlighted in green. 

4 Press the  and  buttons to view the settings for 
other menus. 

You can choose from the following menus:

Settings (set the date, time, beep, and 
 Quick Review mode, and LCD 

brightness). See page 3-12 for more 
information.

Information (turn off the display of 
information on played-back pictures). See 
page 3-5 for instructions.

monitor 
switch

Settings

05/15/99

05:15

: On

: On

menu icons
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Playback Mode (play back images one at a 
time or in groups of 9). See page 3-4 for 
instructions.

Photo Control (erase or lock your pictures, or 
reformat CompactFlash cards). See page 3-6 
and Chapter 8 for instructions.

Video (NTSC or PAL video output to 
standard TV). See page 3-11 for instructions.

Slide Show (play back pictures 
automatically). See page 3-5 for instructions.

Language (select language for LCD display 
and menus). See page 3-15 for instructions.

5 To exit the menus, press the BACK button until the 
menu icons and settings disappear. (Depending on the 
menu, you may have to press this button several times to 
return to playback mode.)

6 When you’re finished with playback mode, slide the 
monitor switch OFF.

Playing Back Pictures One-by-One

When you set the monitor switch to PLAYBACK, you see 
the last picture you took on the LCD monitor, along with 
the image quality and picture number information:

Press the  button to display the previous picture. You 
can continue pressing the button to view your pictures in 
order. Press  to move forward through your pictures.

image 
quality

number of current picture/number of photos taken

13/20
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Playing Back Multiple Pictures

You can play back your pictures in Multi mode to 
view small “thumbnail” versions of nine pictures at 
once. Make sure the monitor switch is set to 
PLAYBACK, and follow these steps:

1 Press the SELECT button to display the monitor 
menus. 

2 Press the  or  button until you see the Playback 
Mode menu. 

3 Press the SELECT button again to choose the Multi 
setting (the checkmark moves to that setting), then press 
the BACK button to exit the menus. 

Thumbnail images of the last photos you took (up to 9 
of them) appear on the LCD monitor, with the 
currently selected image framed in white, as shown on 
the right.

4 Press the  and  buttons to move the white 
selection frame through the images on the LCD 
monitor. When the frame reaches the first or last photo 
of the current group, the previous or next group of up to 
nine images is displayed.

5 To switch back to displaying one picture at a time, 
follow steps 1 through 3 again, but choose the Normal 
setting on the Playback Mode menu.

6 Press the BACK button to return to normal playback 
mode.

Playback Mode

Normal

Multi



Playing Back Pictures  3-5

A

B

Playing Your Pictures as a Slide 

Show

You can use the LCD monitor to automatically 
display each of your pictures, one at a time. Make 
sure the monitor switch is set to PLAYBACK, and 
follow these steps:

1 Press the SELECT button to display the LCD monitor 
menus.

2 Press the  or  button until you see the Slide 
Show option.

3 Press the SELECT button again. The LCD monitor 
begins playing back your pictures one by one.

◗ To move forward or back through the photos 
manually, press the  or  button. 

◗ To pause the slide show at a particular photo, press 
the SELECT button. The pause icon  appears 
next to the picture count on the monitor. Press 
SELECT again to resume the slide show.

4 To stop the slide show, press the BACK button. Press 
BACK again to return to playback mode.

Turning Off Picture Information

The LCD monitor displays the image quality setting 
of each picture along with picture number 
information. You can turn off the information 
display if you want.

Make sure the monitor switch is set to PLAYBACK, and 
follow these steps:

1 Press the SELECT button to display the LCD monitor 
menus.

2 Press the  or  button until you see the 
Information menu.

3 Press the SELECT button to turn information Off. You 
can press it again to turn information back on.

4 To save your setting and return to playback mode, press 
the BACK button. 

Information

On

Off
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Erasing Pictures

The LCD monitor provides different methods for deleting 
images stored in your camera as you play them back: 

◗ You can delete the currently displayed picture

◗ You can select pictures for deletion or delete all the 
pictures

◗ You can “lock” pictures to prevent their deletion

You can erase photos right after you take them, before they 
are stored in your camera, using Quick Review. See 
Chapter 2 for instructions. 

You can also erase stored photos through your software when 
you’re transferring them to your computer. For instructions, 
see Chapter 4.

Erasing the Currently Displayed Picture

Make sure the monitor switch is set to PLAYBACK and the 
image you want to erase is displayed. Then follow these steps:

1 Hold down the FUNCTION button and press the 
BACK button. 

You see the following message on the LCD monitor:

2 Press the SELECT button to erase the picture. The 
monitor returns to playback mode.

NOTE
If you try to erase a locked photo , you see a warning message. 
Press any button to clear the message. See page 3-8 for 
instructions on locking and unlocking images in the camera.

Selecting Pictures to Erase

You select pictures to erase using the Photo Control 
menu. You can either select individual pictures, or 
choose to erase all the pictures in the camera. To 
select pictures to lock (protect from erasing), or lock 
all pictures, see page 3-8.

Confirmation

Erase this 

photo?

Yes : SELECT

 No : BACK
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Before you start, set the playback mode to Multi. This makes 
it easier to select images; see page 3-4 for instructions.

Make sure the monitor switch is set to PLAYBACK, and 
follow these steps to erase pictures:

1 Press the SELECT button to display the LCD monitor 
menus.

2 Press the  or  button until you see the Photo 
Control menu, then press the SELECT button to 
display the menu options:

3 Press the SELECT button to enter Erase mode. The 
Erase Photos menu is displayed:

4 Press the  or  button to choose Select Photo 
or Erase All.

◗ If you chose Erase All, press the SELECT button. 
A message appears asking you to confirm that you 
want to erase all the photos. Press the SELECT 
button to erase the photos; or press the BACK 
button to return to the Erase Photos menu without 
erasing the photos.

◗ If you chose Select Photo, continue with step 5.

5 Press the SELECT button, then press the  or  
button to move the white selection box to the photo you 
want to erase. 

6 Press the SELECT button. The selection box on the 
image turns yellow. If you want to erase other photos at 
the same time, use the  or  button to frame 
them, then press the SELECT button to select them.

NOTE
To cancel the selection of a photo, press the SELECT button 
again.

Photo Control

Erase 

Lock

Reformat

Erase Photos

Select Photo

Erase All
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7 When you have selected all the photos you want to erase, 
press the BACK button. A message appears asking if 
you’re sure you want to erase.

8 Press the SELECT button to erase the images and return 
to the Erase Photos menu. To keep the images, press the 
BACK button, then repeat steps 4 through 7 to reselect 
the photos.

NOTE
If there are locked photos in your camera, you hear a beep 
when you press the SELECT button to indicate that only the 
unlocked images were erased.

9 Press BACK until you return to playback mode.

Locking Photos

The lock feature allows you to keep your photos from being 
accidentally erased. You can lock selected photos or all the 
photos in the camera. 

Make sure the monitor switch is set to PLAYBACK, then 
follow these steps to lock pictures:

1 Press the SELECT button to display the LCD monitor 
menus.

2 Press the  or  button until you see the Photo 
Control menu, then press the SELECT button to 
display the menu options:

3 Press the  button until Lock is highlighted, then 
press the SELECT button to enter Lock mode. The 
Lock Photos menu is displayed:

4 Press the  or  button to choose Select Photo 
or Lock All.

◗ If you chose Lock All, press the SELECT button. 
A message appears asking you to confirm that you 
want to lock all the photos. Press the SELECT 
button to lock the photos. Then press the BACK 
button until you return to normal playback mode.

Photo Control

Erase 

Lock

Reformat

Lock Photos

Select Photo

Lock All

Unlock All
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◗ If you chose Select Photo, continue with step 5.

5 Press the SELECT button, then press the  or  
button to move through the images in the camera until 
the photo you want to lock appears on the monitor.

6 Press the SELECT button. A  lock icon appears in the 
lower left corner. If you want to lock other photos, use 
the  or  button to display them, then press the 
SELECT button to select them.

NOTE
To cancel the selection of a photo, press the SELECT button 
again.

7 When you have selected all the photos you want to lock, 
press the BACK button. The following message appears:

8 Press the SELECT button to lock the images.

9 Press BACK until you return to playback mode.

Unlocking Photos

After you have locked your pictures, you can unlock selected 
photos or all the photos in the camera. 

Make sure the monitor switch is set to PLAYBACK, then 
follow these steps to unlock pictures:

1 Press the SELECT button to display the LCD monitor 
menus.

2 Press the  or  button until you see the Photo 
Control menu, then press the SELECT button to 
display the menu options:

3 Press the  button until Lock is highlighted, then 
press the SELECT button to enter Lock mode. 

Confirmation

Lock/unlock
Photos?

Yes : SELECT

 No : BACK

Photo Control

Erase 

Lock

Reformat
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The Lock Photos menu is displayed:

4 Press the  or  button to choose Select Photo 
or Unlock All.

◗ If you chose Unlock All, press the SELECT 
button. A message appears asking you to confirm 
that you want to unlock all the photos. Press the 
SELECT button to unlock the photos. Then press 
the BACK button until you return to normal 
playback mode.

◗ If you chose Select Photo, continue with step 5.

5 Press the SELECT button, then press the  or  
button to move through the images in the camera until 
the photo you want to unlock appears on the monitor.

6 Press the SELECT button. The lock icon disappears 
from the monitor. If you want to unlock other photos at 
the same time, use the  or  button to display 
them, then press the SELECT button to select them.

NOTE
To cancel the selection of a photo, press the SELECT button 
again.

7 When you have selected all the photos you want to 
unlock, press the BACK button. The following message 
appears:

8 Press the SELECT button to unlock the images.

9 Press BACK until you return to playback mode.

Lock Photos

Select Photo

Lock All

Unlock All

Confirmation

Lock/unlock
Photos?

Yes : SELECT

 No : BACK
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Playing Back Pictures on TV or Video

You can display your pictures on a regular television 
or videotape them with a VCR by using the video 

cable that came with your PhotoPC 650. First, select the 
correct video standard: NTSC (for the US and Canada) or 
PAL (for Europe, South America, and other areas).

Setting the Video Standard

Set the monitor switch to PLAYBACK and follow these 
steps to select a video standard:

1 Press the SELECT button to display the LCD monitor 
menus. 

2 Press the  or  button until you see the Video 
menu:

3 Press the SELECT button to select the video standard 
you want to use.

4 Press the BACK button to return to playback mode.

Playing Back Pictures

Using the optional AC adapter is highly recommended when 
you play back your pictures on a TV. See pages A-1 and A-2 
for instructions and ordering information.

TIP
You can videotape your pictures to share them without using a 
computer. First set the camera’s LCD monitor to Slide Show, as 
described on page 3-5. Then connect the camera to the Video In 
port on your VCR and press the Record button.

Follow these steps to play back your pictures on TV:

1 Make sure the camera and TV (and VCR) are turned off.

2 Open the camera’s card and port cover and connect the 
black end of the video cable to the Video Out port.

Video

NTSC (US/CAN)

PAL (Europe)
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3 Connect the yellow end of the cable to the VIDEO IN 
port on the television or VCR.

4 Turn on the TV (and VCR) and switch to the correct 
video mode.

5 Turn on the camera and slide the monitor switch to 
PLAYBACK. 

6 Press the SELECT button on the back of the camera. 
The last picture you took appears on the TV screen. 
Press the  or  button to move forward or 
backward through your pictures.

7 When you’re finished viewing pictures, press the BACK 
button, slide the LCD monitor switch to OFF, turn off 
the camera, and disconnect the video cable.

Changing Camera Settings

The Settings menu lets you change these camera 
settings:

◗ Current date and time

◗ Alert beep (on or off)

◗ Quick Review mode setting (on [default] or off)

◗ Brightness of the LCD on the back of the camera

Setting the Date and Time

If you ever want to change the camera’s clock settings, set the 
monitor switch to PLAYBACK, then follow these steps:

1 Press the SELECT button to display the LCD monitor 
menus.

2 Press the  or  button until you see the Settings 
menu. The current date and time are displayed.

Settings

05/15/99

05:15

: On

: On
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3 Press the SELECT button once to open the settings 
menu, then press SELECT again to change the month, 
highlighted in white. 

4 Press the  button to increase the number, or the 
 button to decrease the number, until the month is 

correct.

5 Press the SELECT button. The month setting is saved 
and the day setting is highlighted.

6 Adjust the day, year, hour, and minute settings as 
described above until the date and time are correctly 
adjusted and saved.

7 If you need to change the alert beep, Quick 
Review mode, or LCD brightness settings, see the next 
three sections for instructions.

If you’re finished changing settings, press the BACK 
button until you return to playback mode. 

NOTE
You need to reset the time and date whenever you replace the 
camera’s batteries. In this case, you change the settings through 
the Clock Setting menu. See page 1-5 for instructions.

Setting the Alert Beep

The camera’s alert beep lets you know when an image has 
been captured. Set the monitor switch to PLAYBACK, then 
follow these steps to turn the beep on or off:

1 Press the SELECT button to display the menus.

2 Press the  or  button until you see the Settings 
menu. The current beep setting is displayed.

3 Press the SELECT button once to open the settings 
menu, then press the  button to select the beep 
setting icon.

4 Press the SELECT button to select On or Off. The 
current selection is highlighted. When you turn the 
setting on, you hear the camera beep.

5 If you’re finished changing settings, press the BACK 
button until you return to playback mode. 

Settings

05/15/99

05:15

: On

: On
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Selecting Quick Review Mode

Quick Review mode lets you review the picture you just took 
on the LCD monitor and delete it, if necessary, before your 
camera stores it in memory. You can turn off Quick Review 
mode to save additional battery power or if you’d rather not 
use it.

Set the monitor switch to PLAYBACK, then follow these 
steps to turn Quick Review mode on or off:

1 Press the SELECT button to display the LCD monitor 
menus.

2 Press the  or  button until you see the Settings 
menu. The current Quick Review mode setting is 
displayed.

3 Press the SELECT button once to open the settings 
menu, then press  button twice to select the 

Quick Review mode icon.

4 Press the SELECT button to select On or Off. The 
current selection is highlighted. 

5 If you’re finished changing settings, press the BACK 
button until you return to playback mode. 

Setting the LCD Monitor Brightness

You may want to adjust the LCD monitor brightness when 
you’re taking pictures in bright light to make it easier to see. 

Set the monitor switch to PLAYBACK, then follow these 
steps to adjust the LCD brightness:

1 Press the SELECT button to display the LCD monitor 
menus.

2 Press the  or  button until you see the Settings 
menu.Settings

05/15/99

05:15

: On

: On

Settings

05/15/99

05:15

: On

: On
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3 Press the SELECT button once to open the settings 
menu, then press the  button three times to select 
the LCD brightness icon.

4 Press the SELECT button to highlight the LCD 
brightness slider. 

5 Press the  or  buttons to adjust the monitor 
brightness.

6 If you’re finished changing settings, press the BACK 
button until you return to playback mode. 

Setting the Language

You can choose from these six languages for 
information displayed on the camera’s LCD 
monitor: 

◗ English

◗ Español (Spanish)

◗ Portuguese

◗ Français (French)

◗ Deutsch (German)

◗ Italiano (Italian)

Set the monitor switch to PLAYBACK and follow these 
steps to select a language:

1 Press the SELECT button to display the LCD monitor 
menus. 

2 Press the  or  button until you see the Language 
menu:

3 Press the SELECT button to open the Language menu.

4 Press the  or  button until the language you 
want to use is highlighted. (The Français, Deutsch, 
and Italiano settings will scroll onto the monitor as you 
move down.) 

5 Press the SELECT button to choose the highlighted 
language. The LCD display changes automatically to 
that language.

6 Press the BACK button to return to playback mode.

Language

English

Español

Portuguese



3-16   Playing Back Pictures



Getting Photos Into Your Computer   4-1

A

B

.

     hen you’re finished taking pictures, you can W transfer them to your computer, where you can use 
them in the projects you create. This chapter describes the 
following:

◗ Transferring pictures with the JumpShot USB cable

◗ Transferring pictures with the serial cable and HotShots

◗ Getting images into other TWAIN compliant or 
Plug-In compatible applications

◗ What to do if the camera doesn’t respond

The fastest way to transfer your pictures from your camera to 
your computer is using the JumpShot USB cable. If you have 
a Windows 98 system with a USB port or an iMac or Power 
Macintosh G3, you can remove the USB CompactFlash card 
from your camera, insert it in the JumpShot USB cable, and 
transfer pictures directly from the card. See the next section 
for instructions.

4   

If you don’t have compatible USB support on your system, 
you can transfer your pictures by connecting the serial cable 
and using HotShots. See page 4-9 for instructions.

Transferring Photos with the 

JumpShot USB Cable

The fastest way to transfer your pictures from your camera to 
your computer is using the JumpShot USB cable. To transfer 
your pictures using the USB cable, you need the following:

◗ A computer with USB support (Windows 98, iMac, or 
Power Macintosh G3 only; see page 3 in the 
Introduction for details)

◗ The JumpShot USB cable that came with your camera

◗ The Jumpshot USB cable and CompactFlash card 
drivers installed on your computer

Getting Photos Into Your Computer
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On an iMac or Power Macintosh G3, you installed the USB 
drivers when you installed the rest of your camera software (if 
not, see page 1-8). With Windows, you’ll install the drivers 
when your system detects the connected JumpShot USB 
cable and USB CompactFlash card, as described on page 4-4.

To use the JumpShot USB cable to transfer your pictures, 
follow the steps in these sections:

◗ Inserting the card in the cable

◗ Connecting the cable to your computer

◗ Installing the USB drivers (Windows 98 only)

◗ Transferring pictures

◗ Erasing pictures

Inserting the USB CompactFlash Card 

in the JumpShot USB Cable

Follow these CompactFlash card and USB cable precautions:

◗ Insert only a Lexar Media USB 
CompactFlash card in the 
JumpShot USB cable. You can 
identify the USB card by the USB 
logo on the label.

The JumpShot USB cable won’t recognize any other 
type of CompactFlash card

◗ Never insert any other object into the slot on the USB 
cable; you’ll damage the cable components.

◗ Never use a USB extension cable with the USB cable.

Before you can insert the USB CompactFlash card in the 
cable, you need to remove it from the camera. Make sure the 
camera and the LCD monitor are turned off. Then follow 
these steps:

1 Open the card and port cover on the side of the camera. 
Then slide the Eject Card switch on the bottom of the 
camera to eject the card, as shown below.

USB logo
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2 Remove the card by hand, then close the card and port 
cover.

3 Insert the card into the slot in the cable connector with 
the label facing toward the side of the connector 
stamped “USB.” Make sure the pin holes on the card 
face into the connector slot. Push the card all the way 
into the slot.

Connecting the Jumpshot USB Cable

You can connect the USB cable to your computer’s USB 
port or USB hub while your computer is turned on or off.

1 Locate an available USB port or USB hub port on your 
computer system. See your computer documentation for 
instructions.

NOTE
If your system can’t recognize the USB CompactFlash card 
when it’s connected to a USB port on the keyboard or 
monitor of an iMac or Power Macintosh G3, or a hub port on 
any system, connect the USB cable directly to a USB port on 
your computer instead.

2 Position the JumpShot USB 
cable connector so the side 
shown here faces in the 
correct direction for your port. Then connect it to your 
computer’s USB port or USB hub port.

If you have a Windows 98 computer, see the next section for 
instructions on installing the USB CompactFlash card and 
USB cable drivers. If you have a Macintosh, see page 4-7 for 
instructions on transferring your pictures.
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Installing the Windows 98 USB 

CompactFlash Card and USB Cable Drivers

The first time you connect the USB CompactFlash card and 
JumpShot USB cable to your system, you need to install 
their Windows 98 USB drivers using the plug-and-play 
function. Follow these steps:

1 Make sure the USB CompactFlash card is inserted into 
the JumpShot USB cable, and that the cable is 
connected to your computer.

2 Turn on your computer (if it isn’t already turned on). 
During plug-and-play installation, the light on the cable 
turns on. (If it doesn’t turn on, see page 9-4 for 
troubleshooting steps.)

3 You see the Add New Hardware Wizard that tells you 
Windows 98 has detected new hardware on your system. 
Click Next. 

4 You see the screen below. Click Search for the best 
driver for your device. Then click Next.

click this option



Getting Photos Into Your Computer  4-5

A

B

5 You see the screen below. Click CD-ROM drive. Then 
click Next. 

6 You see a message that a driver was located for the USB 
cable, called LexarMedia JumpShot. Click Next, 
then click Finish on the next screen. 

7 You see the Add New Hardware Wizard screen again. 
Repeat steps 2 through 4. 

8 You see a message that a driver was located for the USB 
CompactFlash card, called LexarMedia USB CF 
Mass Storage Device. Click Next, then click Finish 
at the next screen.

To check if your driver installation was successful, do the 
following:

1 Click Start, point to Settings, and click Control 
Panel.

2 Double-click the System icon.

3 Click the Device Manager tab.

4 Click the + next to Universal serial bus controller 
in the device list. You should see LexarMedia 
JumpShot listed as a USB device. 

Transferring Pictures with Windows 98

Follow these steps to transfer your pictures via the JumpShot 
USB cable with Windows 98:

1 Right-click Start, then select Explorer from the pop-
up list. (Or click Start, point to Programs, and click 
Windows Explorer.)

2 You see the Exploring window. Locate the USB 
CompactFlash card drive. 

click CD-ROM 
drive
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The card is identified as the next available drive letter on 
your system and described as a Removable Disk. For 
example, if your hard disk is drive C and your 
CD-ROM is drive D, the USB CompactFlash card is 
assigned as drive E.

Click the + next to the drive letter to open its contents. 

3 You see the Photo650 folder on the card. Click the 
Photo650 folder icon. You see a list of your pictures:

4 Now locate the folder on your computer’s hard disk you 
want to copy the pictures to. For example, if your hard 
disk is drive C and you have a folder called Pictures, 
locate that folder in the Exploring window.

5 Adjust the window as necessary until you can see both 
the Photo650 folder on the card and the folder you 
want to copy the pictures to on your hard disk.

6 To copy all the pictures in the camera at once, click the 
Photo650 folder, hold down the mouse button, and 
drag it to the picture folder on your hard disk. Release 
the mouse button.

To copy individual pictures, click the Photo650 folder 
to open it. Then click the picture in the folder. To copy 
multiple pictures, press either the Shift or Ctrl key as 
you click the pictures you want. Then hold down the 
mouse button, drag the pictures to the picture folder on 
your hard disk, and release the mouse button.

As it accesses data on the card, the light on the USB cable 
flashes. (If your computer enters a power-saving sleep mode, 
the cable light turns off.)

Properly Ejecting the Card

When you’ve finished transferring pictures, close the 
Photo650 folder and exit any open applications. In 
Windows Explorer, right-click the card drive letter (such 
as E:) and click Eject. Then pull the CompactFlash card out 
of the USB cable slot and install it back in your camera.

your 
pictures
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CAUTION
Never remove the USB CompactFlash card or unplug the USB 
cable when the Photo650 folder is open or any applications are 
running on your system. Close the Photo650 folder and exit all 
your applications first.

Always select Eject in Windows Explorer (as described above) or 
wait at least 10 seconds after the last card activity before 
removing the card. 

On some computers, you may have to unplug the JumpShot USB 
cable before removing the USB CompactFlash card from the 
cable slot.

You can disconnect the Jumpshot USB cable from your 
computer, if you want, or leave it connected. However, once 
you remove the USB CompactFlash card, the computer no 
longer recognizes it as a drive.

TIP
If you’re using the JumpShot USB cable to transfer pictures, it’s a 
good idea to check Lexar Media’s web site periodically for 
possible updates to your USB CompactFlash card and JumpShot 
USB cable drivers. Access www.lexarmedia.com for details.

Transferring Pictures with a Macintosh

Follow these steps to transfer your pictures via the JumpShot 
USB cable with an iMac or Power Macintosh G3:

1 Make sure the USB CompactFlash card is inserted into 
the JumpShot USB cable, and that the cable is 
connected to your Macintosh.

2 Turn on your Macintosh (if it isn’t already turned on).

3 You see a diskette icon for the USB CompactFlash card 
on your desktop. Double-click the icon to open the card 
folder, then double-click the Photo650 folder to see 
your picture icons.

your 
pictures

card icon



4-8   Getting Photos Into Your Computer

4 Now locate the folder on your hard disk you want to 
copy the pictures to. For example, if you have a folder 
called Pictures, open that folder on your hard disk.

5 Adjust the folders as necessary until you can see both the 
Photo650 folder on the card and the folder you want to 
copy the pictures to on your hard disk.

6 To copy all the pictures in the camera at once, click the 
Photo650 folder, hold down the mouse button, and 
drag it to the picture folder on your hard disk. Release 
the mouse button.

To copy individual pictures, click the Photo650 folder 
to open it. Then click the picture in the folder. To copy 
multiple pictures, click and drag a box around the 
pictures you want. Then drag the box to the picture 
folder on your hard disk, and release the mouse button.

As it accesses data on the card, the USB cable light flashes. (If 
your Macintosh enters sleep mode, the light turns off.)

Properly Ejecting the Card

When you’ve finished transferring pictures, close the 
Photo650 and card folders and exit any open applications. 
Then drag the card icon into the Trash folder. (Always drag 
the card icon into the trash before removing the card—don’t 
use the Eject command from the Special menu.) Pull the 
CompactFlash card out of the USB cable slot and install it 
back in your camera. See page 1-2 for instructions. 

CAUTION
Never remove the USB CompactFlash card or unplug the USB 
cable when the Photo650 folder is open or any applications are 
running on your system. Close the Photo650 folder, exit all your 
applications, and drag the card icon into the Trash folder first.

You can disconnect the Jumpshot USB cable from your 
Macintosh, if you want, or leave it connected. However, 
once you remove the USB CompactFlash card, the 
Macintosh no longer recognizes it as a drive.

TIP
If you’re using the JumpShot USB cable to transfer pictures, it’s a 
good idea to check Lexar Media’s web site periodically for 
possible updates to your USB CompactFlash card and JumpShot 
USB cable drivers. Access www.lexarmedia.com for details.
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Erasing Pictures

It’s best to erase the pictures from the USB CompactFlash 
card after you re-install it in your camera using the camera’s 
Reformat mode (see page 1-7 for instructions). However, 
you can also erase pictures from the card while it’s connected 
to your computer by the JumpShot USB cable.

To erase pictures from the card, select the pictures inside the 
Photo650 folder and press the Delete key. Then confirm 
the deletion at the prompt.

Transferring Pictures with the Serial 

Cable

Follow the steps in these sections to transfer your pictures 
directly from the camera using the serial cable and HotShots:

◗ Connecting the camera to a Windows PC or Macintosh

◗ Transferring pictures using HotShots

NOTE
When the camera is connected to your system, you can’t use any 
of the camera controls.

To save battery power, you can leave the camera turned off as 
you transfer the pictures or connect the optional AC adapter, as 
described in Appendix A.

Connecting the Camera to a Windows PC

Make sure you have the serial cable that came with your 
camera. Before you start, turn off the camera, LCD monitor, 
and your computer. 

1 Locate a serial port on the back of your computer. You 
may have two serial ports labeled COM1 and COM2, or 
they may be labeled with icons. For the best results, use 
COM1 (port 1) to connect your camera.

NOTE
If you have a 25-pin serial port, you can use a 9- to 25-pin 
adapter, available at most computer stores.
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2 Line up the serial connector on the cable with one of the 
serial ports on your computer, and insert the connector. 
Then tighten the screws. 

3 Open the card and port cover on the side of the camera. 
Then insert the other end of the cable into the camera’s 

serial port.

4 Turn on your computer system. 

NOTE
If you have problems connecting to your COM port, check your 
computer’s COM port settings and try again. If you have a high-
speed serial board, you may be able to transfer pictures at 
230.4Kb per second. See page 4-23 for instructions on changing 
your Port speed setting with EPSON PhotoPC 650 TWAIN.

Connecting the Camera to a Macintosh

Make sure you have the long serial cable and short 
Macintosh adapter that came with your camera. Before you 
start, turn off the camera, LCD monitor, and Macintosh.

NOTE
On a PowerPC Macintosh, you may be able to transfer your 
pictures at 230.4Kb per second. See page 4-23 for instructions on 
selecting your Port setting with the EPSON PhotoPC 650 Plug-In.

1 Connect the small Macintosh adapter cable to either the 
 modem port or  printer port on the back of your 

Macintosh. 
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Line up the arrow on the cable connector with the port 
icon on your Macintosh. Then insert the connector.

.

NOTE
If you share a serial port with another device, make sure 
AppleTalk™ is turned off. Your Macintosh may not recognize 
the camera if AppleTalk is on. Also, if you have problems 
connecting to the printer port, use the modem port instead.

2 Connect the long serial cable to the short Macintosh 
adapter cable, then tighten the screws. 

3 Open the card and port cover on the side of the camera 
and insert the connector on the long serial cable into the 
camera’s serial port.

4 Turn on your Macintosh system.

Transferring Pictures Using HotShots

To transfer your pictures via the serial cable using HotShots 
and the EPSON PhotoPC 650 TWAIN (Windows) or Plug-
In driver (Macintosh), follow the steps in these sections:

◗ Opening the EPSON PhotoPC 650 TWAIN or Plug-In 
driver

◗ Saving pictures to a folder, or 

◗ Transferring pictures into HotShots

Macintosh 
adapter
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Opening the EPSON PhotoPC 650 TWAIN or 

Plug-In Driver

1 Connect the camera to your computer using the serial 
cable; see page 4-9 for instructions.

2 Start HotShots.

In Windows, double-click the HotShots icon on your 
Windows desktop. (Or click Start, point to Programs, 
PhotoPC 650, and then click HotShots 1.5.)

On a Macintosh, open the PhotoPC650 folder, then 
open the HotShots folder and double-click the 
HotShots icon. 

3 You see the main HotShots 
window with the remote 
control on the right side. 
Click the Get button on 
the remote control, then 
click Get from Camera.

4 Click the arrow in the Select Camera menu. Then click 
EPSON PhotoPC 650 TWAIN (Windows) or 
EPSON PhotoPC 650 (Macintosh).

5 Click the Get Pictures Now button. You see the Get 
Pictures window:

6 Click the Open Them button.

NOTE
If you select Add to New Collection or Add to Existing 
Collection, you may see a dialog box allowing you to change the 
transfer file format. It’s best to keep your files in the JPEG format 
because of their small size and quick transfer speed. This only 
affects files you transfer into HotShots (see page 4-16); it doesn’t 
affect files you save to your hard disk (see page 4-15).

On a Macintosh, if no existing collection is open and you select 
Add to Existing Collection, HotShots prompts you right away to 
select a collection file.

Get 
button

Get from 
Camera

Select 
Camera 
menu
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You see the EPSON PhotoPC 650 TWAIN or Plug-In 
window (the Windows screen is shown below). The 
pictures in your camera appear in the window.

(If you don’t see the pictures in your camera when you 
open the window, click Open Camera. If that doesn’t 
work or you see an error message, see page 4-23.)

If the current transfer speed displayed on the Camera 
Content tab is 57600 or lower, see the next section to 
select a faster transfer speed.

When you’re ready to select the pictures you want to 
transfer, see page 4-14.

Changing the Picture Transfer Speed

If the current transfer speed displayed on the Camera 
Content tab is 57600 or lower, you can change it to speed 
up the transfer. Follow these steps:

1 Click the Setup tab. You see the Setup screen:

2 Click the arrow in the Speed setting list to open it. 
Then select 115200 (for Windows) or 230400 (for 
Macintosh). If your system won’t support these faster 
speeds, select the next lower speed.

3 Click the Camera Content tab to select the pictures 
you want to transfer, as described in the next section.

pictures in 
your camera

Camera Content 
tab

Setup tab current transfer speed

Speed 
setting
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NOTE
The Speed setting you selected is not displayed on the Camera 
Content tab unless you click the Open Camera button; however, 
your pictures will still transfer at the new rate.

Selecting Pictures to Transfer

There are three ways to select pictures to transfer:

◗ Click an individual picture

◗ Hold down the Shift or Ctrl key (Windows) or the 

 

J 
key (Macintosh) and click multiple pictures

◗ Click the Select All button to select all of them.

Your selected pictures are outlined in red.

NOTE
To permanently erase a picture from your camera, select it and 
click Erase, then confirm the erasure.

Once you’ve selected pictures, you’re ready to transfer them 
to your camera. See the next section.

Transferring Pictures From the Camera to Your 

Computer

There are two ways to transfer your pictures from your 
camera to your computer: Save to Folder and Transfer.

selected 
pictures

Transfer button

Save to Folder 
button
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◗ The fastest method is Save to Folder. This lets you 
transfer your pictures and save them directly to a 
selected folder on your hard disk, saving battery power 
and time. See the next section for instructions.

◗ You can also use Transfer to import your pictures into 
HotShots, but they are stored in your computer’s RAM 
(memory), not saved directly to your hard disk. See 
page 4-16 for instructions.

NOTE
If your camera shuts off automatically while you’re transferring 
pictures (to save battery power), click the Open Camera button 
on the TWAIN or Plug-In window to “wake it up.”

Saving Pictures to a Folder

1 To save your pictures to a folder on your hard disk, click 
the Save to Folder button. You see one of these dialog 
boxes:

2 Select the folder you want to save your pictures to, or 
click the Create New Folder (Windows) or New 
folder button (Macintosh) to create a new folder. 

Windows

File naming field

Save as type list
Macintosh

New folder button

Create New Folder 
button
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NOTE
To select a different default folder for the program to use 
each time you open it, click the Setup tab on the window 
and click Browse under Default Photo Folder. 

3 If you want to save your pictures in a format other than 
JPEG, select it from the Save as type list (Windows 
only). On a Macintosh, you can also type in a different 
file name for the image files in the file naming field. 

4 When you’re ready to transfer your pictures, click Save.

As the files are transferred, they are either automatically 
given a generic name (Windows) or given the name you 
selected (Macintosh), and then numbered sequentially. 

To cancel a transfer in progress, click Cancel 
(Windows) or press the J and . keys (Macintosh).

5 Close the EPSON PhotoPC 650 TWAIN or Plug-In 
windows and return to HotShots. 

You’ll need to open your pictures from disk to use them 
in your image editing application. To open them in 
HotShots, see Chapter 6 for instructions. To import 
them with another application, see Chapter 5.

Transferring Pictures into HotShots

1 To transfer your pictures into HotShots, click the 
Transfer button. 

◗ If you selected Open Them in step 6 on page 4-12, 
HotShots automatically transfers the pictures into 
your computer’s memory, opens them in individual 
windows, and numbers the windows sequentially. 

CAUTION
The pictures are not yet saved to your computer’s hard disk.

◗ If you selected Add to New Collection, HotShots 
transfers your pictures into a new collection window 
and saves them to the HotShots collection folder. 

◗ If you selected Add to Existing Collection, 
HotShots transfers them into an open collection or 
prompts you to open the collection you want to 
transfer them to. Then HotShots saves the pictures 
in the same folder as the collection.
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NOTE
If you see a memory error message while transferring 
pictures, close the EPSON PhotoPC 650 TWAIN or Plug-In 
window and use the Save to Folder method to transfer your 
pictures instead. See page 4-15 for instructions. (You may 
also need to close and then reopen HotShots to free-up your 
computer’s memory.)

To cancel a transfer in progress, click Cancel 
(Windows) or press the J and . keys (Macintosh).

2 After your pictures are transferred, close the EPSON 
PhotoPC 650 TWAIN or Plug-In window and return to 
HotShots. You see the picture(s) in the HotShots 
window. To work with your pictures and collections in 
HotShots, see Chapter 6.

TIP
If you don’t want to select a transfer method each time you open 
TWAIN or the plug-in with HotShots, open the Edit menu and 
select Preferences, Acquire, Bring Pictures Into, and choose a 
specific transfer method. You can also select other transfer 
preferences this way. See HotShots’ help utility for details.

Getting Images Into Other TWAIN or 

Plug-In Applications

If you use Adobe Photoshop or other TWAIN-compliant 
or Plug-In compatible applications, you can transfer your 
pictures directly into your program from the camera. 

Make sure you’ve already connected the camera to your 
computer using the serial cable, as described on page 4-9 
(Windows) or page 4-10 (Macintosh).

Before you can use the EPSON PhotoPC 650 Plug-In with 
other applications on a Macintosh, you must copy the 
Plug-In driver into the application’s Plug-In folder. 

Follow the steps in these sections:

◗ Copying the EPSON PhotoPC 650 Plug-In driver 
(Macintosh)

◗ Opening EPSON PhotoPC 650 TWAIN or Plug-In

◗ Saving pictures to a folder, or transferring pictures into 
your TWAIN-compliant or Plug-In compatible 
application



4-18   Getting Photos Into Your Computer

Making an EPSON PhotoPC 650 Plug-In 

Driver Alias (Macintosh)

1 Open the PictureWorks folder on your hard disk, then 
open the HotShots folder within it.

2 Now open the Plug-ins folder and click the EPSON 
PhotoPC 650 Plug-In icon.

3 Open the File menu and select Make Alias. An 
EPSON PhotoPC 650 Plug-In alias icon is created.

4 Click and drag the Plug-In alias to your Macintosh 
desktop.

5 Locate your application’s Plug-In folder. Then click and 
drag the Plug-In alias from your desktop to the folder.

Opening EPSON PhotoPC 650 TWAIN or 

Plug-In

1 Connect the camera to your computer using the serial 
cable; see page 4-9 for instructions.

2 Start your application. 

3 Windows: From the File menu, choose Import, then 
Select TWAIN_32 Source (or Acquire, then 
TWAIN Select Source). Go to step 4.

Macintosh: From the File menu, select Import, then 

select EPSON PhotoPC 650 Plug-in. Go to step 6.

4 Choose EPSON PhotoPC 650 TWAIN as the 
TWAIN source, then click Select.

5 From the File menu, choose Import, then TWAIN_32 
(or Acquire, then TWAIN Acquire).
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6 You see the EPSON PhotoPC 650 TWAIN or Plug-In 
window (the Windows screen is shown below). The 
pictures in your camera appear in the window. 

(If you don’t see the pictures in your camera when you 
open the window, click Open Camera. If that doesn’t 
work or you see an error message, see page 4-23.)

If the current transfer speed displayed on the Camera 
Content tab is 57600 or lower, see the next section to 
select a faster transfer speed.

When you’re ready to select the pictures you want to 
transfer, see page 4-20.

Changing the Picture Transfer Speed

If the current transfer speed displayed on the Camera 
Content tab is 57600 or lower, you can change it to speed 
up the transfer. Follow these steps:

1 Click the Setup tab. You see the Setup screen:

2 Click the arrow in the Speed setting list to open it. 
Then select 115200 (for Windows) or 230400 (for 
Macintosh).

3 Click the Camera Content tab to select the pictures 
you want to transfer, as described in the next section.

pictures in 
your camera

Camera Content 
tab

Setup tab current transfer speed

Speed 
setting
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NOTE
The Speed setting you selected is not displayed on the Camera 
Content tab unless you click the Open Camera button; however, 
your pictures will still transfer at the new rate.

Selecting Pictures to Transfer

There are three ways to select pictures to transfer:

◗ Click an individual picture

◗ Hold down the Shift or Ctrl key (Windows) or the 

 

J 
key (Macintosh) and click multiple pictures

◗ Click the Select All button to select all of them.

Your selected pictures are outlined in red.

NOTE
To permanently erase a picture from your camera, select it and 
click Erase, then confirm the erasure.

Once you’ve selected pictures, you’re ready to transfer them 
to your camera. See the next section.

Transferring Pictures From the Camera to 

Your Computer

There are two ways to transfer your pictures from your 
camera to your computer: Save to Folder and Transfer.

selected 
pictures

Transfer button

Save to Folder 
button
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◗ The fastest method is Save to Folder. This lets you 
transfer your pictures and save them directly to a 
selected folder on your hard disk, saving battery power 
and time. See the next section for instructions.

◗ You can also use Transfer to import your pictures into 
your application, but they are stored in your computer’s 
RAM (memory), not saved directly to your hard disk. 
See page 4-22 for instructions.

NOTE
If your camera shuts off automatically while you’re transferring 
pictures (to save battery power), click the Open Camera button 
on the TWAIN or Plug-In window to “wake it up.”

Saving Pictures to a Folder

1 To save your pictures to a folder on your hard disk, click 
the Save to Folder button. You see one of these dialog 
boxes:

2 Select the folder you want to save your pictures to, or 
click the Create New Folder (Windows) or New 
folder button (Macintosh) to create a new folder. 

Windows

File naming field

Save as type list
Macintosh

New folder button

Create New Folder 
button
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NOTE
To select a different default folder for the program to use 
each time you open it, click the Setup tab on the window 
and click Browse under Default Photo Folder. 

3 If you want to save your pictures in a format other than 
JPEG, select it from the Save as type list (Windows 
only). On a Macintosh, you can also type in a different 
file name for the image files in the file naming field. 

4 When you’re ready to transfer your pictures, click Save.

As the files are transferred, they are either automatically 
given a generic name (Windows) or given the name you 
selected (Macintosh), and then numbered sequentially. 

To cancel a transfer in progress, click Cancel 
(Windows) or press the J and . keys (Macintosh).

5 Close the EPSON PhotoPC 650 TWAIN or Plug-In 
window and return to your application. 

You’ll need to open your pictures from disk to use them 
in your image editing application. To open them in 
HotShots, see Chapter 6 for instructions. To import 
them with another application, see Chapter 5.

Transferring Pictures Into Your Application

1 To transfer pictures into your application, click the 
Transfer button. The pictures are automatically 
transferred into your computer’s memory, opened in 
individual windows in your application, and numbered 
sequentially. 

CAUTION
The pictures are not yet saved to your computer’s hard disk.

To cancel a transfer in progress, click Cancel 
(Windows) or press the J and . keys (Macintosh).

NOTE
If you see a memory error message while transferring 
pictures, close the EPSON PhotoPC 650 TWAIN or Plug-In 
window and use the Save to Folder method to transfer your 
pictures instead. See page 4-21 for instructions. (You may 
also need to close and then reopen your application to free-
up your computer’s memory.)

2 After your pictures are transferred, close the EPSON 
PhotoPC 650 TWAIN or Plug-In window and return to 
your application. You see the picture(s) in the 
application window. 
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3 To save your pictures in your application, click a picture 
window and select your application’s Save command. 
(Check your application’s help utility for detailed 
instructions.)

What To Do If the Camera Doesn’t 

Respond

If you don’t see your camera’s pictures in the EPSON 
PhotoPC 650 TWAIN or Plug-In window and you see an 
error message like this one, follow the steps in this section.

1 Click the Open Camera button on the Camera 
Content tab. If you still don’t see your pictures and the 
error message appears again, continue with step 2.

2 Click the Setup tab on the window and make sure the 
Port option is set to either Auto Detect (Windows) or 
Auto (Macintosh). For best results, try setting the Speed 
to 115200 (Windows) or 230400 (Macintosh).

3 Click the Camera Content tab, then click Open 
Camera again. If you still don’t see your pictures and 
the error message appears again, continue with step 4.

4 Check the cable and make sure the connections are 
secure, and the pins inside the connector are not bent.

Speed 
setting

Port setting
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5 Make sure your batteries have enough power, or your 
AC adapter is connected. If your camera automatically 
shuts off (to save battery power), “wake” it by turning it 
off and on again.

6 Click Open Camera again. If you still don’t see your 
pictures and the error message appears again, continue 
with step 7.

7 Close the EPSON PhotoPC 650 TWAIN or Plug-In 
window and try transferring your pictures again. 

If you still don’t see your pictures and the error message 
appears again, see Chapter 9 for more troubleshooting 
tips.
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Gardening Monthly
November 1998

Sunflowers
Sunflowers are big-leafed, sturdy plants that need
full sun and moist soils.  Seeds attract birds.
Perennial species grow rapidly, forming sizable
clumps that can become invasive.  Plant in large
gardens or parks.  Start by division or seed.  All
bloom in late summer and fall.

Recipe of the Month
Grilled Cactus Pads

*  1 pound cactus leaves        * Olive Oil

This is an interesting treat for a cookout.  Scrub cactus leaves
well with a vegetable scrubber to remove any spines that may
be on them.  With the end of a potato peeler cut around the
spiney nodules and remove them. Make sure that all are
removed.  Grill the leaves over charcoal or wood fire for 10
to 12 minutes on each side.  Thicker leaves may take slightly
longer to grill.  Brush leaves with oil occasionally while
grilling.  Serve hot.

New Next Month

Orchid Mania

Landscaping Page 2

Bulbs  Page 3

Book Reviews Page 4

Seeds        Page 5

Supplies        Page 6

Cactus Fever
Large, round or cylindrical cacti with deep
accordianlike ribbing and prominent spines
comprise this group of Mexican and Southwestern
U.S. natives.  They vary in size and shape, but all
are easy to grow and can reach 10 ft. tall and wide.
Spring and summer flowers bloom in pink or
yellow in a circle at the plant’s crown.  Don’t plant
where children are present.

-  Focus on Echinocatus

This print sample was created using actual 1024x768 pixel images taken with the EPSON PhotoPC 600 XGA color digital camera.  It was
printed with the EPSON Stylus Color 600 printer at 1440 dpi on EPSON Photo Quality Glossy Paper.

hotoPC 650 provides several methods for gettingPyour pictures into newsletters, flyers, and other 
projects. You can import an image into your application, 
or copy and paste it. You can even drag and drop a picture 
from a HotShots collection directly into a document 
(Windows only). This chapter describes the following:

◗ Importing images into documents

◗ Getting images with copy and paste

◗ Using drag and drop from a HotShots collection 
(Windows only)

NOTE

Although most of the instructions and illustrations in this chapter apply 

to Windows, you can follow the same steps on a Macintosh (if 

applicable).

Getting Your Photos Into Documents

ch5.fm  Page 1  Thursday, November 4, 1999  1:49 PM
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Importing Images Into Documents

Once your pictures are transferred and saved on your hard 
drive, you can import them into your applications. If your 
application can’t import JPEG files, you can use the Save As 
feature of HotShots to convert them to another format; see 
HotShots online help for instructions.

NOTE
Your picture may display poor image quality after you import it. 
However, in most cases it will print correctly.

Follow these steps to import a picture into your document:

1 Start your word processor or other application.

2 Open the document in which you want to use the 
picture.

3 Select the point where you want to place your picture.

4 Select Picture from the Insert menu, then select From 
File. (In some applications you may need to select 
different commands, such as Import Picture, which are 
usually in the File menu.) A file selection dialog box 
appears.

5 Locate and select the image you want to insert. In some 
applications you can see a preview of your picture.

6 Click OK (or Insert, Import, or whatever command 
your application uses) to insert your picture. The picture 
appears in your document.



Getting Your Photos Into Documents  5-3

A

B

NOTE
In some applications, you can add a frame around the picture if 
you want to move it around on the page or resize it. In other 
applications, you create a frame first, and then place the picture in 
it. For instructions, see your application’s online help or 
documentation.

Getting Images with Copy and Paste

You can use this method to place a picture in just about any 
type of document or project. Follow these steps:

1 Open your picture in HotShots; see page 6-2 for 
instructions.

2 From the Edit menu, 
click Select All. A 
dotted border appears 
around your picture.

3 Now select Copy from the Edit menu.

4 Start your word processor or other application.

5 Open the document in which you want to use the 
picture.

6 Select the point where you want to place the picture.

7 Choose Paste (or Paste Special) from the Edit menu. 
A copy of the picture appears in your document.

Using Drag and Drop From a 

Collection

Once you have organized your pictures into HotShots 
collections, you can easily drag and drop them into 
documents or other projects (Windows only). For more 
information on using HotShots collections, see Chapter 6.

NOTE
Dragging and dropping an image into a document works only with 
OLE-2.0-compliant applications, such as Microsoft Word, 
PowerPoint, WordPerfect, or Lotus SmartSuite. Depending 
on how well your application supports OLE 2.0, your images may 
not look as good when you drag and drop them as when you 
import them.

dotted 
border
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Follow these steps:

1 Start HotShots as described on page 4-11.

2 Click Get on the remote 
control to open the Get 
menu, if necessary. Then 
select Get from Disk.

3 Click the Open a 
Collection button. You 
see the Open dialog box.

4 Locate the collection you 
want and double-click the 
collection name to open it. 

5 Start your word processor 
or other application.

6 Open the document in which you want to use the 
picture. Arrange the window for HotShots so it is next 
to the window for your application.

7 Click the image you want to copy from the HotShots 
collection.

8 While holding down the mouse button, drag the image 
to the location where you want it in your document.

9 Release the mouse button. The picture appears in your 
project or document in the other application.

Get button

Get from 
Disk

Open a 
Collection

click the picture . . .

hold down the mouse 
button . . .

and drag it to your 
document
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6   

ou can use HotShots collections to organize yourY pictures, add identifying information to them, and 
even display them in slide shows. You can also print your 
pictures or collections and put them in dozens of 
predefined layouts, including pages that combine different 
pictures of various sizes. This chapter covers the 
following:

◗ Opening pictures and collections

◗ Saving modified pictures

◗ Organizing pictures in collections

◗ Printing pictures and collections

◗ Using Photo Page layouts

◗ Displaying collections as slide shows

Working with Photos and Collections

Action Travel, Inc. Action Travel, Inc. Action Travel, Inc. Action Travel, Inc. 
1357 World Drive, Torrance, CA  90509

Escape On An Affordable
Outdoor Adventure!

Great Summer Weekend Specials

Sailing
Expedition

$250 All-Inclusive Package for Either Outing!

Please Call Our Helpful Representatives for More Information
310-555-5555

National Park
Excursion

ch6.fm  Page 1  Thursday, November 4, 1999  2:17 PM
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Opening Pictures and Collections

You can open individual pictures in HotShots, or open a 
collection and then open the picture from there. For 
instructions on starting HotShots, see page 4-11.

TIP
The first time you use HotShots, you should calibrate your 
monitor so your pictures look their best on screen. Click the Get 
button, then select Open a Picture. Select the calibrat.bmp 
(Windows) or calibrat.pct (Macintosh) file in the HotShots folder 
and click Open. (Windows path: Program Files/PictureWorks/
HotShots; Macintosh: PictureWorks, HotShots folder.) You see a 
grayscale strip numbered 0 through 10. Adjust your monitor’s 
brightness and contrast until you can clearly see the 0 and 10; 
then close the picture.

Opening an Individual Picture

Follow these steps to open a picture that’s not in a collection:

1 Click the Get button on the remote control. 

2 Select Get from Disk and click the Open a Picture 
button. (You can also select Open Picture from the 
File menu.)

3 You see the Open dialog box. 
Open the folder where you 
saved the picture, highlight the 
picture file, and click Open. 
Your picture opens in a 
window.

Opening a Collection

Follow these steps to open a collection, and then open a 
picture from it:

1 Click the Get button on the remote control. 

2 Select Get from Disk and click the Open a 
Collection button. (You can also select Open 
Collection from the file menu.) 

3 You see the Open dialog box. Open the folder where 
you saved your collection, highlight the collection, and 
click Open. 
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4 Your collection 
opens in a 
window.

5 To open a picture in the collection, double-click it. The 
picture opens in its own window, as shown to the left. 
(To add pictures to a collection, see “Adding or Deleting 
Pictures in Collections” to the right.) 

Saving Pictures

When you save changes you make to your pictures, it’s best 
to save your picture with a new name so you always have 
your original; see page 6-5. 

However, you can save your picture with the same name, if 
you like. Just select Save Picture from the File menu.

NOTE
If you try to close a picture that you have made changes to, 
HotShots asks if you want to save your changes or not. If you 
choose Yes, your picture is saved with the same name 
automatically. If you choose No, your changes aren’t saved.

Using Collections

HotShots collections provide a convenient way to access and 
view your pictures. Here are some of the things you can do 
with collections:

◗ Add or delete pictures in collections

◗ Move or copy pictures from one collection to another

◗ Rename pictures and collections

◗ Add information to your pictures—such as a subject or 
description—to make finding specific pictures easier

Adding or Deleting Pictures in Collections

There are two ways to add a picture to your collection: using 
drag-and-drop and using the Add button.

To drag and drop a picture into a collection, open the 
picture and collection as described on page 6-2. Then click 
the gray grab bar on the picture, drag it to the collection 
window, and release the mouse button. 
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The picture appears in the collection window.

To add an unopened picture, click the Add button on 
the taskbar in the collection window. You see the Add to 
Collection dialog box. Select the picture you want to add and 
click Add (Windows) or Open (Macintosh). The picture 
appears in the collection window.

To delete a picture from a collection, click it; a green line 
appears around the picture. To select multiple pictures for 
deletion, hold down the Ctrl (Windows only) or Shift key as 
you click the pictures. Then click the Delete button. You 
see a confirmation message; click Yes.

Organizing Pictures in Collections

You can easily drag and drop images between HotShots 
collections to organize them in any way you want. 

Follow these steps to copy pictures from one collection to 
another:

1 Follow the steps on page 6-2 to open the collection 
where the pictures are located. Then open the collection 
you want to copy the images to. 

2 Click the picture or pictures you want to move or copy; 
a green line appears around your selection. Hold down 
the Ctrl (Windows only) or Shift key to select multiple 
pictures.

click the gray grab bar . . .

hold down the mouse 
button . . .

then drag the picture to 
the collection window

selected 
pictures
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3 Then click inside one of the selected images and hold 
down the mouse button. Drag the image(s) to the other 
collection window and release the mouse button. The 
images are copied to the collection.

Saving a Picture with a New Name

You can easily rename a picture in the HotShots window or 
in a collection. Follow these steps:

1 Open the picture as described on page 6-2. In a 
collection, double-click the picture; it opens in its own 
window.

2 Select Save As from the File menu. You see the Save As 
dialog box.

3 Select a location to store your renamed file. Then type in 
the new name and click Save. You see the JPEG 
Options dialog box. 

4 Click OK. The new name appears above the picture (in a 
window) or below the picture (in a collection).

Adding Collection Information

To quickly add a text and/or recorded description to your 
entire collection, follow these steps: 

1 Open your collection as described on page 6-2.

2 Click the Collection Info button. Type a 
description in the field on the Collection Image 
Properties dialog box.

3 To record voice information for your collection, click 
Record. You see this dialog box:

copied 
pictures
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NOTE
Your computer must be set up to record sound before you 
can use the Record function. See your computer 
documentation for details.

4 Click the Record button to record your message, 
then click the Stop button when you’re finished. To 
play back your message, click the Play button. With 
a Macintosh, you can also pause the message playback 
with the Pause button.

5 When your message is how you want it, click Save. You 
see the Collection Image Properties dialog box.

6 Click OK to save your collection information.

Adding Picture Information

You can add information to pictures in your collections to 
make it easy to find them by criteria such as subject, 
keywords, or description. Follow these steps:

1 Open your collection as described on page 6-2.

2 Select the picture or pictures you want to add 
information to.

3 To quickly add a keyword to multiple pictures, click the 
Add to Keywords button. Type a keyword in the 

field on the Add Keyword dialog box and click OK.

To add multiple information items to one picture, click 
the File Info button on the collection taskbar. You 
see the Collection Image Properties dialog box.

Enter a subject, keywords, and/or description to help 
identify your picture in the dialog box fields. Then 
click OK. 

The information is saved with the picture so you can 
view it or search for it, as described in the next sections.

Subject field

Keyword field

Description field

picture file 
location
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Viewing Picture Information

To view basic information about a picture outside of a 
collection—such as resolution, file size, file type, or folder 
location—click on the picture and select Get Info from the 
Image menu. 

To view basic information plus any descriptive information 
that you added to a picture in a collection, follow these steps:

1 Open your collection as described on page 6-2.

2 Click the picture you want to view information on.

3 To view the picture alongside its descriptive 
information, click the Card View button to change 
the collection view. Use the scroll bar to check 
information on other pictures in your collection.

To view the descriptive information and change it at the 
same time, if necessary, click the File Info button 
on the collection taskbar. You see the Collection Image 
Properties dialog box, shown to the left.

Searching for Pictures in a Collection

To find a picture or set of pictures in a collection, you can 
search for them by a variety of identification criteria. 

Follow these steps to search in a collection:

1 Open your collection as described on page 6-2.

2 Click the Find button on the taskbar. You see the 
Find in Collection dialog box.

3 Select the search criteria you want to use in the Find 
Where fields, as described in the following table.

Search criterion Modifier Description

Name (file name) contains Enter the whole name, part of the 
name, or even one letter of the name

Kind (file type) is Select a file type from the list or 
choose all image files; choose from: 
.BMP, .EPS, .FPX, .GIF, .JPG, .PCX, 
.PCD, .PSD, .PCT, or .TIF

Date modified is, is not, is 
before, or is 
after

Enter a date in mm/dd/yy format

Size (file size) is less than
is greater than

Enter a file size in kilobytes (KB)

Subject contains Enter the whole subject, part of the 
subject, or even one letter of the 
subject you added

Keywords contains Enter one or more of the keywords 
you added

Description contains Enter the whole description, part of 
the description, or even one letter of 
the description you added
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4 Click Find. If the first picture matching the search 
criteria is found, the picture is highlighted. If no picture 
is found, you see a message.

5 To find another picture matching the search criteria, 
click Find Next. 

Printing a Picture or Collection

HotShots offers many choices for printing an individual 
picture or collection. You can:

◗ Print an individual picture at full size (one per page)

◗ Print multiple copies of the picture on one sheet of 
paper

◗ Size your picture to a standard photo size, such as wallet 
size or 5 × 7, printing either one or multiple copies on a 
sheet of paper

◗ Use HotShot’s Smart Print feature to print a test strip 
with varying image quality settings and adjust your 
picture before you print

◗ Print an entire collection of pictures and include 
descriptive information about them, if you like

Printing an Individual Picture

To print an individual picture at the size of your paper, 
first open the picture you want to print; see page 6-2 for 
instructions.

Printing with Windows

1 Select Printer Setup from the File menu. Make sure 
your printer is selected and click the Properties button.

2 Select the print settings for your printer, making sure to 
select the correct paper size setting. (See your printer 
manual for instructions.) 

3 Select Print from the File menu. You see the Print 
dialog box. Click OK to print your picture.

Printing on a Macintosh

1 Select Page Setup from the File menu. Select some of 
the print settings for your printer, making sure to select 
the correct paper size setting. (See your printer manual 
for instructions.) 

2 Select Print from the File menu. You see the Print 
dialog box. Select the rest of your print settings, then 
click Print to print your picture.
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Sizing and Printing Multiple Copies of an 

Individual Picture

Follow these steps to print an individual picture at a different 
size and/or in multiple copies on a single page:

1 Open the picture you want to print; see page 6-2 for 
instructions.

2 Click Share on the remote control to open the Share 
menu. Then select Print Pictures from the menu.

3 Select the size at which you want to print your picture, 
as described in the following table.

4 Select the number of copies of your picture you want 
printed on one page:

◗ 1 per page prints a single copy of your picture. If 
the picture’s proportions are different than the size 
you selected in step 3, it is sized to fit on the paper 
size you select in step 5 with its initial proportions.

◗ Fill Page prints multiple copies of the picture at 
the size you select in step 5, filling the printable area 
on the paper size you select in step 6.

Share button

Print Pictures 
option

Size setting Description

Wallet Size 2 × 3 inches (5.08 × 7.62 cm)

3 X 5 7.62 × 12.70 cm

4 X 6 10.16 × 15.24 cm

5 X 7 12.70 × 17.78 cm

Fit to page Prints as large as possible on the paper size you select 
in your print settings.
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5 Do one of the following:

◗ Windows: Select Printer Setup at the bottom of 
the Share menu on the remote control. (You can 
also select Printer Setup from the File menu.) 
Make sure your printer is selected and click the 
Properties button.

Select the print settings for your printer, making 
sure to select the correct paper size setting. (See your 
printer manual for instructions.) When you return 
to the Printer Setup dialog box, click OK.

Select Print It Now from the bottom of the Share 
menu. You see the Print dialog box. The number of 
picture copies that will print on the page is shown in 
the Print dialog box.

◗ Macintosh: Select Page Setup at the bottom of 
the Share menu on the remote control. (You can 
also select Page Setup from the File menu.)

Select some of the print settings for your printer, 
making sure to select the correct paper size setting. 
(See your printer manual for instructions.)

Select Print It Now from the bottom of the Share 
menu. You see the Print dialog box. Select the rest 
of your print settings. The number of picture copies 
that will print on the page is shown in the Print 
dialog box.

NOTE
The print options you select from the Share menu on the 
remote control affect your print job only if you select Print It 
Now from the remote control. They do not affect print jobs 
printed from the Print option in the File menu, which 
produces only pictures that are fit to the page size.

6 Click OK (Windows) or Print (Macintosh) to print 
your picture(s).
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Printing a Picture with Smart Print

The HotShots Smart Print feature lets you quickly adjust the 
sharpness and brightness of your picture before you print it. 
The Smart Print setting you select is then applied to any 
other pictures you print until you change the setting.

You use Smart Print by printing a test strip of an area of your 
picture using nine different sharpness and brightness 
settings. Then you select the example you want to use to set 
the image quality and print your adjusted picture.

Follow these steps to print with Smart Print:

1 Open the picture you want to print; see page 6-2 for 
instructions.

2 Click Share on the remote control to open the Share 
menu. Then select Print Pictures from the menu.

3 Select Smart Print from the bottom of the Share menu 
on the remote control. (You can also select Smart Print 
from the File menu.) 

You see the Smart Print dialog box:

Nine Smart Print setting examples using different 
sharpness and brightness levels are shown in the middle 
of the dialog box, with the currently selected setting 
outlined and described beneath.

The image area used in the examples is in the middle of 
your picture by default, but you can select a new area.

Smart Print setting examplesimage area marker
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4 To select new area, click the image area marker and drag 
it to a new location; then release the mouse button. The 
new image area appears in the nine Smart Print setting 
examples.

5 You can print a page containing all the examples so you 
can select the one you want to use. Click Print Test 
Strip. You see the Print dialog box. Click OK to print.

6 Examine the printed test strip to determine which 
example looks the best. Click that example in the Smart 
Print dialog box; the new example is outlined.

7 Click OK when you’re finished.

8 Now follow the steps in either “Printing an Individual 
Picture” on page 6-8 or “Sizing and Printing Multiple 
Copies of an Individual Picture” on page 6-9 to print 
your picture using the new Smart Print setting.

The Smart Print setting you choose applies to any 
subsequent pictures you print. To change the setting, repeat 
the steps in this section.

NOTE
The results you get with Smart Print depend on your current 
printer driver settings; see your printer manual for details.

Printing a Collection

Follow these steps to print an entire collection of pictures 
using the currently selected collection view:

1 Open the collection you want to print; see page 6-2 for 
instructions.

2 Select the format in which you want your collection 
printed by choosing a view in the collection window:

◗ Click Large Icon View for a slide-size format 
with file names beneath each picture.

◗ Click Small Icon View for a small thumbnail of 
each picture.

view selection buttonsprint icon
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◗ Click Line View for a smaller thumbnail format 
with file names and other picture information to the 
right of each picture.

◗ Click Card View for a large view of each picture 
printed on one page with its file name and other 
picture information to the right. After printing the 
first picture, click in the scroll bar on the right of 
the collection window to print the next picture.

3 Do one of the following:

◗ Windows: Click the Print button. You see the 
Print dialog box. Make sure your printer is selected 
and click the Properties button.

Select the print settings for your printer, making 
sure to select the correct paper size setting. (See your 
printer manual for instructions.) When you return 
to the Print dialog box, click OK to print your 
collection.

◗ Macintosh: Select Page Setup from the File 
menu. Select some of the print settings for your 
printer, making sure to select the correct paper size 
setting. (See your printer manual for instructions.) 

Then click the Print button. You see the Print 
dialog box. Select the rest of your print settings, 
then click Print to print your collection.

Using Creative Templates

HotShots supplies a variety of templates you can use to 
display your photos in creative frames, called Photo Pages. 
Once you drag and drop one or more pictures into a Photo 
Page, you can modify them and add text to the page, if you 
like. Then you can save and print the Photo Page.

Creating a Photo Page

Follow these steps to create a HotShots Photo Page:

1 Open a picture, or a collection containing the picture 
that you want; see page 6-2 for instructions.

2 Click Share on the remote control to open the Share 
menu. 
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Then select Make 
Photo Page from 
the menu.

3 Select a category of 
Photo Page 
templates you’d like 
to use, such as 
Sports, Labels, or 
Holiday. The 
available Photo 
Pages for the 
category appear in 
the list below the category.

4 To view the Photo Page choices, click the up or down 
arrow in the list. When you find the Photo Page you 
want, click it. A Photo Page window opens:

5 Arrange the Photo Page window and your picture or 
collection window so you can see them both.

Share button

Make Photo 
Page option

template 
categories

Photo Page list

import or drag 
pictures into 
these areas
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6 To import a picture into your Photo Page, you can drag 
and drop a picture or select a picture file from disk.

◗ To import an image 
that is not in a 
collection, place the 
mouse cursor in the 
gray grab bar 
between the image 
and the title bar; the 
cursor changes to a 
hand. Click and drag 
the picture to a 
Photo Page location; 
then release the mouse button.

◗ To import an image from a collection, click the 
picture in the collection window and drag it to a 
Photo Page location; then release the mouse button.

◗ To import an image from disk, double-click a 
picture import area in the Photo Page template and 
select the file from the Open dialog box.

Your imported picture appears in the Photo Page.

7 To import another photo in a different area of your 
template, repeat step 6. (To delete a picture you 
imported, select Undo from the Edit menu.)

8 Now follow the steps in the next few sections to modify 
your Photo Page, then save it and print it, if you like.

Modifying a Photo Page

Once you’ve created a Photo Page, you can modify it by 
moving the picture, increasing or decreasing the picture size, 
and adding text.

Follow these steps to modify a Photo Page:

1 Create a Photo Page as described on page 6-13.

2 To modify the picture in the Photo Page, click in the 
picture area you want to modify. 

gray 
grab 
bar
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Four control boxes appear in the corners:

3 Use the tools in the Photo Page window taskbar to 
adjust the size and position of the picture:

◗ Click the  Enlarge tool, then click in the picture 
area to enlarge its size 10% with each mouse click.

◗ Click the  Reduce tool, then click in the picture 
area to reduce its size 10% with each mouse click.

◗ Click the Pan tool, then click and drag the 
picture to reposition it.

4 To add text to the Photo Page, click the Text tool. 
Then click and drag the mouse over the area where you 
want to place a text box and type your text in the box. 

5 Now click on the text box border; the border becomes 
striped with control boxes in each corner. 

◗ To resize or reposition your text box, click and drag 
the striped border. 

◗ To edit the text, click inside the text box where you 
want the cursor positioned and add or delete text.

control 
boxes

text box
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6 To format all the text in the box, click any of the text 
options you want to use in the taskbar:

7 If you need to delete a text box, select it and press the 
Delete key on your keyboard (Windows) or select 
Clear from the Edit menu (Macintosh).

8 Once your Photo Page looks how you want it to, you 
can save it or print it, as described on page 6-18.

Saving a Photo Page

You can save a Photo Page in one of a variety of file formats, 
such as .JPG, .BMP, or .TIF. However, you may want to 
save it in the default Photo Page format (.SSD) so you can 
edit the Photo Page later, if you need to. 

Follow these steps to save a Photo Page:

1 Select Save As from the File menu. You see the Save As 
dialog box.

2 Select the location where you want to store your Photo 
Page, then select the file type in the Save as type list. 

NOTE
If you select a file type other than the Photo Page format 
(.SSD), the picture, text, and template will be “fused” to 
create a single image. You won’t be able to modify it as a 
Photo Page in the future.

3 Type a name for your Photo Page file and click Save.

To open a saved Photo Page, select Open Picture from the 
file menu, locate the Photo Page (.SSD) file, and click 
Open.

bold, italic, 
and underline

left, center, and 
right align text color

point size font



6-18   Working with Photos and Collections

Printing a Photo Page

Follow the steps below to print your completed Photo Page.

Printing with Windows

1 Select Printer Setup from the File menu. Make sure 
your printer is selected and click the Properties button.

2 Select the print settings for your printer, making sure to 
select the correct paper size setting. (See your printer 
manual for instructions.) 

3 Select Print from the File menu. You see the Print 
dialog box. Click OK to print your picture.

Printing on a Macintosh

1 Select Page Setup from the File menu. Select some of 
the print settings for your printer, making sure to select 
the correct paper size setting. (See your printer manual 
for instructions.) 

2 Select Print from the File menu. You see the Print 
dialog box. Select the rest of your print settings, then 
click Print to print your picture.

Displaying Collection Slide Shows

You can display each photo in your collection on your full 
monitor screen, one at a time, just like a slide show. Before 
playing it, you can select from a variety of transition effects 
to use between the pictures. 

Follow these steps to display a collection slide show:

1 Open the collection you want to display as a slide show; 
see page 6-2 for instructions.

2 Click the Slide Show button in the collection 
taskbar. You see a slide option dialog box:
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3 Select the type of transition you’d like to use for the first 
picture and between pictures, as described in this table:

4 Select how you want to display the slide show:

◗ Wait for Mouse Click displays the next slide only 
if you click the mouse button

◗ Pause lets you select a delay time between slide 
transitions from 5 to 30 seconds

◗ Loop Continuously displays all the slides, then 
starts over again automatically

5 Click OK to start the slide show. To stop a slide show in 
progress, press the Esc key on your keyboard.

Transition Type Description

Random Transitions 
(Windows)
Random (Macintosh)

Randomly uses all of the other transition types 
between pictures

Wipe Down Replaces pictures by rolling down over them, like 
a window shade being pulled down

Wipe Up Replaces pictures by rolling up over them, like a 
window shade being raised

Wipe Left Replaces pictures by rolling left across them

Wipe Right Replaces pictures by rolling right across them

Horizontal Blinds Replaces pictures in horizontal strips, like window 
blinds

Vertical Blinds Replaces pictures in vertical strips, like window 
blinds

Box In Replaces pictures from the outside edges inward, 
like an imploding box

Box Out Replaces pictures from the center outward, like 
an exploding box

Random Blocks Replaces pictures in a pattern of randomly placed 
blocks
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5.

7   

ou can edit your images to enhance their appearance, Ycrop, rotate, and resize them, or create special 
effects. This chapter describes these HotShots image 
editing features:

◗ Flip, rotate, resize, and resolution adjustment tools for 
basic adjustments

◗ Quick Fix for fast, automatic image adjustment

◗ SmartPix for automatically optimizing images based 
on how they were captured (camera, scanner, Internet, 
etc.) and the lighting conditions of the photo

◗ Fix By Example for changing a variety of image 
characteristics using on-screen before and after 
examples

◗ Special Effects for applying an assortment of fun and 
creative effects to your photos

Editing Images
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Making Basic Adjustments

You can make these basic adjustments to your pictures using 
the Image menu tools in the HotShots menu bar:

◗ Flip the picture horizontally or vertically

◗ Rotate the picture 90 or 180 degrees

◗ Resize the picture

◗ Change the resolution (Windows only)

Flipping

Follow these steps to flip the picture horizontally or 
vertically:

1 Open the picture you want to edit. See page 6-2 for 
instructions.

2 Point to Flip in the Image menu. You see a submenu 
with Horizontal and Vertical options; click the 
direction you want to flip the picture.

The picture in the window changes to reflect your 
selection:

(If you change your mind about the edit, select Undo 
from the Edit menu.)

3 To save your edited picture, see page 6-3 for 
instructions. Be sure to give your picture a new name, if 
you want to save the original picture as it was.

original image flipped horizontally flipped vertically
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Rotating

You can rotate your picture 90 degrees clockwise or 
counterclockwise, or 180 degrees to turn it upside down. 
This is especially useful for pictures taken with your camera 
rotated 90 degrees, such as portraits; these pictures retain 
their rotation when you transfer them.

Follow these steps to rotate a picture:

1 Open the picture you want to edit. See page 6-2 for 
instructions.

2 Point to Rotate in the Image menu. You see a submenu 
with these options:

◗ 90 Degrees Counter Clockwise

◗ 90 Degrees Clockwise

◗ 180 Degrees

Click the direction you want to rotate the picture. The 
picture in the window changes to reflect your selection. 
You may need to resize the picture window to see the 
entire image. 

(If you change your mind about the edit, select Undo 
from the Edit menu.)

3 To save your edited picture, see page 6-3 for 
instructions. Be sure to give your picture a new name, if 
you want to save the original picture as it was.

original image
rotated 90 degrees counterclockwise

rotated 90 degrees clockwise rotated 180 degrees
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Resizing

You can resize your image to make it larger or smaller, or 
change its shape. Follow these steps:

NOTE
When you enlarge a picture, you may lose some details from the 
original. To retain image quality, increase a picture’s resolution 
before enlarging it (Windows only); see page 7-5 for instructions.

1 Open the picture you want to edit. See page 6-2 for 
instructions.

2 Select Resize from the Image menu. You see the Resize 
Options dialog box:

3 The size of the original picture is displayed on top. To 
change the measurement units, click the Units drop-
down menu and select pixels, inches, or cm 
(centimeters).

4 Enter a new width and height for the picture.

To preserve the width and height proportions of your 
original picture, leave the Preserve Aspect Ratio 
checkbox checked. To change the picture’s proportions 
to the width and height you specify, click the checkbox 
to uncheck it; this may distort your picture.

5 Click OK. The picture in the window changes to reflect 
your selection. (You may need to resize the picture 
window to see the entire image.)

If you preserved the picture’s aspect ratio in step 5, the 
new size may be adjusted from the size you entered to 
keep the proportions the same.

(If you change your mind about the edit, select Undo 
from the Edit menu.)

6 To save your edited picture, see page 6-3 for 
instructions. Be sure to give your picture a new name, if 
you want to save the original picture as it was.
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Adjusting Resolution (Windows Only)

You can adjust the resolution of your image to make it 
sharper and so it can be enlarged without losing detail. 
However, the higher the resolution, the larger the file size, so 
keep your system resources in mind as you adjust resolution.

NOTE
Adjusting a picture’s resolution also changes the picture’s size. 
Be sure to resize the picture, if necessary, after changing its 
resolution. See page 7-4 for instructions.

Follow these steps to adjust your image resolution:

1 Open the picture you want to edit. See page 6-2 for 
instructions.

2 Select Resolution from the Image menu. You see the 
Change Resolution dialog box:

3 The resolution of the original picture is displayed on top 
in pixels per inch. To change the measurement units, 
click the Units drop-down menu and select inches or 
cm (centimeters).

4 Enter higher numbers in the Horizontal and Vertical 
field to increase the resolution, or lower numbers to 
decrease it.

5 To change the resolution equally both horizontally and 
vertically, leave the Uniform Resolution checkbox 
checked. You then need to enter a new number in only 
one of the fields. To use different horizontal and vertical 
resolutions (for advanced printing needs, for example), 
click the checkbox to uncheck it; however, this may 
distort your image.

6 Click OK. The resolution is changed, but you see no 
on-screen changes to your picture.

(If you change your mind about the edit, select Undo 
from the Edit menu.)

7 To save your edited picture, see page 6-3 for 
instructions. Be sure to give your picture a new name, if 
you want to save the original picture as it was.
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Optimizing Pictures with Quick Fix

The easiest way to optimize your picture is to use HotShot’s 
Quick Fix command to automatically adjust it. Quick Fix 
gives you cleaner, brighter images while maintaining the 
highlight and shadow detail. However, if your original image 
has intense highlights or shadows, it’s better to adjust it using 
Fix By Example, as described on page 7-8.

Follow these steps to use Quick Fix:

1 Open the picture you want to edit. See page 6-2 for 
instructions.

2 Click the Enhance button on the remote control to 
open the Enhance menu.

3 Click Quick Fix. The picture in the window changes to 
reflect your changes. (You can zoom into the image to 
see the changes more clearly; click Zoom In from the 
Image menu.)

(If you change your mind about the edit, select Undo 
from the Edit menu.)

4 To save your edited picture, see page 6-3 for 
instructions. Be sure to give your picture a new name, if 
you want to save the original picture as it was.

Optimizing Pictures with SmartPix

HotShot’s SmartPix feature lets you optimize your image 
quality based on these characteristics:

◗ the device you used to capture the image (Internet, 
camera, scanner, or other device)

◗ whether the photo was taken inside or outside

◗ the lighting conditions under which the photo was taken

Smart Pix uses device profiles built into the HotShots 
program to determine the level and type of corrections to 
make to your image. To experiment with corrections, you 
can use SmartPix multiple times to “layer” the effects, if you 
like.

Enhance button

Quick Fix option
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Follow these steps to use Smart Pix:

1 Open the picture you want to edit. See page 6-2 for 
instructions.

2 Click the Enhance button on the remote control to 
open the Enhance menu.

3 Click SmartPix. You see the SmartPix editing window.

4 If the portion of the picture shown in the example area is 
too small or you want to see a different example area, 
click and drag the example area selector to choose a new 
area. Drag the edges of the selector to enlarge the area; 
drag the middle of the selector to reposition it.

5 Click the arrow in the device drop-down list and select 
the type of device used to capture your photo: Camera, 
Internet, Scanner, or Other Device.

Enhance button

SmartPix option

before and after change examples example area selector

device drop-
down list

location/lighting 
conditions
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6 Select the location where the picture was taken, either 
inside or outside.

7 Select the lighting conditions under which the photo 
was taken. If you chose inside, select with a flash, 
fluorescent lighting, shadows, or faded colors. If 
you chose outside, select sunny day, cloudy day, 
some shadows, lots of shadows, or faded colors.

8 The effects of each selection in steps 5 through 7 are 
shown in the With Changes example in the SmartPix 
window. Remember, you can layer changes over 
previous changes—such as sunny day and some 
shadows—to get the effect you want.

9 If you don’t like the results, click Cancel Changes at 
the bottom of the remote control. 

To keep your changes and return to the main HotShots 
window, click Done. (You can still cancel your 
SmartPix changes by selecting Undo from the Edit 
menu.)

10 To save your edited picture, see page 6-3 for 
instructions. Be sure to give your picture a new name, if 
you want to save the original picture as it was.

Enhancing Pictures with Fix By 

Example

HotShot’s Fix By Example feature lets you make a series of 
corrections to a picture’s brightness, intensity, color tint, and 
sharpness by selecting from on-screen examples.

Follow these steps to use Fix By Example:

1 Open the picture you want to edit. See page 6-2 for 
instructions.

2 Click the Enhance button on the remote control to 
open the Enhance menu.

Enhance button

Fix By Example 
option
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3 Click Fix By Example. You see the By Example 
editing window:

4 If the portion of the picture shown in the example areas 
is too small or you want to see a different example area, 
click and drag the example area selector to choose a new 
area. Drag the edges of the selector to enlarge the area; 
drag the middle of the selector to reposition it.

5 Click the characteristic you want to correct: 
Brightness, Intensity, Color Tint, or Sharpness. 

The key example in the center represents the original 
image. The surrounding eight examples indicate varying 
corrections of the characteristic, with the least correction 
of it in the upper left and the most correction of it in the 
lower right. 

To adjust the amount of variation shown in the 
examples, slide the variation slider in the remote control 
to the right or left.

6 Click the example that looks best to you; that example 
moves to the center and the surrounding examples 
adjust to reflect less or more correction proportionately. 
Click an example as many times as you wish to get the 
results you want. (To undo the change you made, click 
Reset on the remote control.)

7 To adjust a different image characteristic, repeat steps 5 
and 6 to further correct the image.

8 Once the With Changes and Zoomed Changes images 
look the way you want them to, click Done to save your 
changes and exit to the HotShots main window. (To 
undo the changes you made, click Cancel Changes.) 

(If you change your mind about the edit, select Undo 
from the Edit menu.)

example with least correction example area selector

charac-
teristic 
buttons and 
variation 
slider

example with most correctionkey example in center
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9 To save your edited picture, see page 6-3 for 
instructions. Be sure to give your picture a new name, if 
you want to save the original picture as it was.

Applying Special Effects

To transform your images in creative ways, you can apply 
special effects to your pictures. Choose one or more of the 
effects in the table below.

Follow these steps to apply special effects:

1 Open the picture you 
want to edit. See 
page 6-2 for 
instructions.

2 Click the Enhance 
button on the remote 
control to open the 
Enhance menu.

3 Click Special 
Effects. 

Effect Description

Squish Image is pulled into the center, like a concave mirror

Stretch Image is pulled out from the center, like a convex mirror

Zig Zag Image is pulled side-to-side in strips, with zigzag edges

Oil Paint Image is blurred and softened, like an oil painting

Water Color Image is brushed softly, like a watercolor painting

Puzzle Image is overlaid with a puzzle pattern

Cool Edges Image color boundaries are traced for a vibrant neon effect

Under Glass Image pixels are scattered, like looking through textured glass

Emboss Image tone is evened and pressed in, resulting in a stamped 
effect

Motion Blur Image is blurred to simulate movement

Soften Image is blurred to simulate an out-of-focus photograph

Hide Identity Image pixels are enlarged and appear in blocks, like a 
photograph with the subject’s identity obscured

Fracture Image pixels are rotated in blocks, resulting in a shattered look

Paper 
Textures

Image is overlaid with a choice of paper textures

Man Made 
Textures

Image is overlaid with a choice of manufactured textures, 
such as brick or vinyl

Natural 
Textures

Image is overlaid with a choice of natural textures, such as 
water reflections or woodgrain

Effect Description

Enhance button

Special Effects 
option
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You see the Special Effects editing window:

4 When you first open the Special Effects window, the 
Before Changes and Zoomed Changes examples 
represent the original image. The examples to the left 
indicate varying levels of the Squish effect (the default 
effect), with the least squished example in the upper left 
and the most squished in the lower right.

If the portion of the picture shown in the example areas 
is too small or you want to see a different example area, 
click and drag the example area selector to choose a new 
area. Drag the edges of the selector to enlarge the area; 
drag the middle of the selector to reposition it.

5 To adjust the amount of variation shown in the 
examples, slide the variation slider in the remote control 
to the right or left (if available). To select a different 
effect, click its button; use the arrows to view all the 
effect buttons.

6 Click the example that has the type or level of effect you 
want; that example is shown as the new With Changes 
and Zoomed Changes example. The example images to 
the left now display more extreme effects. Click an 
example as many times as you wish to get the results you 
want. 

(To undo the change you made, click Reset on the 
remote control.)

7 To apply another special effect, click the button for it on 
the remote control and follow steps 5 and 6 again to 
further correct the image.

example with weakest effect example area selector

effect 
buttons 
and 
variation 
slider

example with strongest 
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8 Once the With Changes and Zoomed Changes 
examples look the way you want them to, click Done to 
keep your changes and exit to the HotShots main 
window. (To undo all the changes you made, click 
Cancel Changes.) 

(If you change your mind about the edit, select Undo 
from the Edit menu.)

9 To save your edited picture, see page 6-3 for 
instructions. Be sure to give your picture a new name, if 
you want to save the original picture as it was.

Using Enhancement Tools

HotShots offers a wide variety of image enhancement tools 
you can use to customize your images. In addition, you can 
crop your images and correct common photographic flaws, 
such as red eye and dust specks. To add a special message to 
your pictures, you can add text.

Follow these steps to use the Enhancement tools:

1 Open the picture you 
want to edit. See page 6-2 
for instructions.

2 Click the Enhance 
button on the remote 
control to open the 
Enhance menu.

3 Click Tools. You see 
an assortment of 
enhancement tools and 
tool options. The tool 
options vary depending on 
the currently selected tool. 

4 To use a tool, click on it; then select any tool options 
you want to use. Move the cursor over your open 
picture; the cursor turns to a shape representing the tool.

Follow the steps in the next sections to zoom into your 
picture, select a picture enhancement area, select color 
options, use the enhancement tools, and add text.

Enhance 
button

Tools 
option

tools

tool 
options
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Zooming

It’s easier to enhance your picture when your view of it is 
larger. To zoom into and out of your pictures, click the 

Zoom tool. Then click the zoom in or zoom out tool 
option and click in your picture; the view is reduced or 
enlarged by 50%. 

To select a specific view percentage, click the arrow in the 
100% drop-down menu and select a setting.

The picture window remains the same size as you zoom. To 
enlarge your window, click and drag the edges as necessary.

Selecting an Enhancement Area

You can use the shape selection tools to select a portion of 
your picture for enhancement or select the entire picture.

If you need to delete a selection area, choose Select None 
from the Edit menu or press the Esc key on your keyboard.

Select All

Choose Select All from the Edit menu to select the entire 
picture; a dotted border appears on your picture.

Shape Selection

To select an area with a basic geometric shape—such as a 
square, rectangle, circle, or oval—click the Shape 
Selection tool. 

dotted 
selection 
border
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Follow these steps to use the Shape Selection tool:

1 Choose either the square/rectangle or circle/oval tool 
option to select the shape you want. 

2 Use the Feathering slider to smooth or harden the 
edges of selection area.

3 Move the cursor to the area in your picture where you 
want to begin drawing the shape; the cursor is a pointed 
arrow.

To draw a rectangle or oval, click and drag the mouse 
over the picture; then release the button. To draw a 
perfect square or circle, hold down the Shift key 
(Windows) or the Control key (Macintosh) as you click 
and drag the mouse.

Lasso

To select an area with a polygon shape or a shape you decide 
yourself, click the Lasso tool. Then follow these steps:

1 Choose either the freehand or polygon tool 
option to select the lasso shape you want. 

2 Use the Feathering slider to smooth or harden the 
edges of selection area.

3 Move the cursor to the area in your picture where you 
want to begin drawing the shape; the cursor is a lasso 
(for freehand tool) or pointed arrow (for polygon tool).

◗ To draw a freehand shape, click and drag the mouse 
over the picture in any shape you wish; then release 
the button. If the shape doesn’t meet at both ends, a 
straight line appears connecting the two points.

◗ To draw a polygon, click and release the mouse 
button. Then move the cursor to the next corner of 
your polygon and click and release the mouse 
button again; a straight line appears connecting the 
two points. To constrain the polygon angles to 
either 45 or 90 degrees, hold down the Shift key 
(Windows) or the Control key (Macintosh) as you 
click the mouse button. 

Continue drawing your polygon, then double-click 
the mouse button when you’re finished. 
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Magic Wand

HotShots includes a helpful Magic Wand tool that can 
automatically select a portion of your image based on the 
relative pixel value of a point you select. Relative pixels are 
those with the same color, hue, brightness, saturation, and 
vibrancy compared to the surrounding pixels.

For example, if your picture has a flare effect in a bright 
white area (as in a photo of snow), you can use the Magic 
Wand tool to select only the flared area for correction.

To automatically select an area with relative pixel values, 
click the Magic Wand tool. Then follow these steps:

1 Use the Sensitivity slider to adjust the level of 
discrimination in determining relative pixels. The 
middle setting is usually the best, but you can choose 
higher (+) settings for increased sensitivity or lower (–) 
settings for decreased sensitivity.

2 Use the Feathering slider to smooth or harden the 
edges of selection area.

3 Move the cursor to the 
area in your picture on 
which you want to 
change the relative 
pixels; the cursor is a 
magic wand. Aim the 
upper tip of the wand 
on the spot you want 
and click the mouse 
button. HotShots 
automatically creates a 
selection area of relative pixels.

Selecting Colors

There are two ways to select the color you want to use for 
foreground and background enhancements to your image: 
the color wheel and the eyedropper.

Using the Color Wheel

To select the color you want to use 
for an enhancement tool from the 
color wheel, click the foreground 
box of the Foreground/Background 
tool.

dotted 
selection 
border

foreground 
box

background 
box
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To select a background color to appear behind your image 
when you remove image elements, click the background box 
of the Foreground/Background tool. You see the Color 
Wheel dialog box. 

Windows: Click a color in the wheel or enter R (red), G 
(green), B (blue), H (hue), S (saturation), and V (vibrancy) 
values for the color you want to use. Adjust brightness using 
the scroll bar. Then click OK.

Macintosh: Select a color model in the scroll bar on the left, 
then select the color you want to use. Adjust the available 
values for the colors and click OK.

Using the Eyedropper

You can use the eyedropper to select a foreground color by 
sampling one from your image. 

Click the Eyedropper tool. Then move the cursor to the 
area in your picture containing the color you want to use; the 
cursor changes to an eyedropper. Click to select the color. 
The foreground box of the Foreground/Background tool 
changes to that color.

Cropping an Image

If you want to save only part of your image, you can crop out 
the portion you don’t want. Cropping makes your image 
smaller than the original, so be sure to save it with a different 
name to preserve your original image.

To delete any changes you make with this tool, select Undo 
from the Edit menu. You can repeatedly select Undo to 
reverse multiple edits, or select Redo to replace the changes 
you undid. To delete all the changes made since you last 
saved the picture, select Revert from the File menu.

Windows Macintosh
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To crop an image, click the Crop tool. Then follow these 
steps:

1 Move the cursor to the area in your picture outside of 
which you want to crop; the cursor looks like the Crop 
tool.

2 Click and drag the mouse 
over the picture area you 
want to keep; then release 
the mouse button. A crop 
border appears.

3 If you need to adjust the 
size of the crop border, 
click in one of the corner 
boxes and drag it to a new 
position.

4 When you’re ready to 
crop the picture, click 
once inside the crop 
border; the area outside 
the border disappears. (To 
undo a crop, select Undo 
from the Edit menu.)

Using Paint and Drawing Tools

You can customize your pictures using HotShots’ versatile 
painting and drawing tools. 

To delete any changes you make with these tools, select 
Undo from the Edit menu. You can repeatedly select Undo 
to reverse multiple edits, or select Redo to replace the 
changes you undid. To delete all the changes made since you 
last saved the picture, select Revert from the File menu.

Paint Brush

To paint strokes on your picture like those of a paint brush, 
click the Paint Brush tool. Then follow these steps:

1 Choose the line weight, solidity, and transparency of the 
paint stroke with the line attribute options.

crop 
border

cropped 
picture

diffused line

solid line

transparency slider

line weight



7-18   Editing Images

Select the weight of line from either the diffused line or 
solid line row. Adjust the transparency slider to allow 
your picture to show through the line, if you like.

2 Select a color for your design as described on page 7-15.

3 Move the cursor to the area in your picture where you 
want to begin painting; the cursor is a paint brush. Aim 
the tip of the brush on the place you want to start, then 
click and drag the mouse to paint your design.

Air Brush

To paint strokes on your picture like those of an air brush or 
spray paint, click the Air Brush tool. Follow these steps:

1 Choose the line weight, solidity, and transparency of the 
paint stroke with the line attribute options, shown on 
page 7-17. Select the weight of line from either the 
diffused line or solid line row. Adjust the transparency 
slider so your picture shows through the line, if you like.

2 Select a color for your design as described on page 7-15.

3 Move the cursor to the area in your picture where you 
want to begin painting; the cursor is a spray can. Aim 
the top of the can on the place you want to start, then 
click and drag the mouse to paint your design.

Fill Selection

The Fill tool lets you paint solid portions of your image as if 
you’d poured paint on them. There are two types of Fill 
tools: Fill Selection (below) and Fill Color Match (see the 
next section).

Fill Selection lets you fill in an area of your picture you 
already specified with the area selection tools, as described on 
page 7-13. If you use the tool but don’t select an area, the 
whole picture is filled.

To fill a selected enhancement area, click the Fill tool. 
Then follow these steps:

1 Click the Fill Selection tool option.

2 Select a color for your fill as described on page 7-15.

3 Move the cursor to the selection area in your picture; the 
cursor is a paint bucket. Click the mouse button; the 
area is filled with the selected foreground color.

Fill Color Match

Fill Color Match automatically fills a portion of your image 
based on the relative pixel value of a point you select. 
Relative pixels are those with the same color, hue, brightness, 
saturation, and vibrancy compared to the surrounding pixels.
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For example, if your photo contains an area of color that you 
want to change to another color, use the Fill Color Match 
tool to change it.

To fill an area with relative pixel values, click the Fill 
tool. Then follow these steps:

1 Click the Fill Color Match tool option.

2 Use the Sensitivity slider to adjust the level of 
discrimination you want HotShots to use when 
determining relative pixels. The middle setting is usually 
the best, but you can choose higher (+) settings for 
increased sensitivity or lower (–) settings for decreased 
sensitivity.

3 Select a color for your fill as described on page 7-15.

4 Move the cursor to the 
area in your picture on 
which you want to fill the 
relative pixels; the cursor is 
a paint bucket. Click the 
mouse button. HotShots 
automatically creates a fill 
of the relative pixels.

Smudge

The Smudge tool lets you blur the distinction of colors in an 
image area to remove blemishes, blend colors, and smooth 
harsh lines. 

Click the Smudge tool, then follow these steps:

1 Choose the line weight, solidity, and pressure of the 
smudge stroke with the line attribute options.

Select the weight of smudge line from either the diffused 
line or solid line row. Adjust the pressure slider to 
increase or decrease the intensity of the smudge.

Color 
Match 
Fill area

diffused line

solid line

pressure slider

line weight
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2 Move the cursor to the area in your picture you want to 
smudge; the cursor is a pointing finger. Aim the tip of 
the finger on the place you want to start smudging. 
Then either:

◗ Click and release the mouse button repeatedly over 
the areas you want to smudge; this thoroughly 
blends local colors

◗ Click and hold down the mouse button and drag 
the cursor over a larger area you want to smudge.

Clone

The Clone tool lets you copy one part of your picture onto 
another part by painting the replication onto the image. 
Click the Clone tool, then follow these steps:

1 Choose the line weight, solidity, and transparency of the 
clone stroke with the line attribute options.

Select the weight of line from either the diffused line or 
solid line row. Adjust the transparency slider to the left 
(more transparent) for a more faded cloned image, or to 
the right (less transparent) for an exact clone.

2 Move the cursor to the area in your picture you want to 
replicate; the cursor is two paintbrushes. Aim the tip of 
the left brush on that area. Then hold down the Ctrl key 
(Windows) or Option key (Macintosh) on your 
keyboard and click the mouse button.

before smudging, a hair 
hangs against the 
background

after smudging, hair 
disappears into the 
background

diffused line

solid line

transparency slider

line weight
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3 Now position the cursor on the area in your picture 
where you want to start painting the cloned image. Click 
and hold down the mouse button; a crosshair appears on 
the area you selected in step 2. 

Drag your mouse on the image to paint in the cloned 
image. The crosshair and clone brush move in tandem as 
you paint. You can paint as much as you wish, in any 
direction. 

Line

To draw straight lines on your image at any angle, in any 
color, click the Line tool. Then follow these steps:

1 Choose the width of the line you want to draw (in 
pixels) by entering a number from 1 to 9 in the Stroke 
Size tool option. Stroke Size 1 is one pixel wide and 
Stroke Size 9 is 15 pixels wide.

2 Select a color for your line as described on page 7-15.

3 Move the cursor to the area in your picture where you 
want to begin drawing the line; the cursor is a crosshair. 
Click and drag the mouse to draw the line.

To constrain the angle of the line to one of eight, 
45 degree angles, hold down the Shift key as you click 
and drag the mouse.

original image with one child cloned image of child painted to 
the right
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Drawing Shapes

To draw geometric and freeform shapes on your picture, 
click the Drawing Shapes tool. Then follow these steps:

1 Click a shape from this table and select its tool options:

2 Select a fill type for any of the shapes from these options:

◗  Outline and Fill outlines in the foreground 
color and fills with the background color

◗  Outline Only outlines in the foreground color 
and the picture shows through the middle

◗ Fill Only fills the shape with the background 
color, but does not outline it

3 Choose the width of the line you want to use to draw the 
shape (in pixels) by entering a number from 1 to 9 in the 
Stroke Size tool option. 

4 Depending on the fill type you chose in step 2, select a 
foreground and background color as necessary for your 
shape as described on page 7-15.

5 Move the cursor to the area in your picture where you 
want to begin drawing the shape; the cursor is a 
crosshair. 

For a circle, oval, square, rectangle, or equilateral 
polygon, click and drag the mouse to draw the shape. 
For a freeform polygon, click and release the mouse 
button, then move the cursor and repeat to draw each 
side. Then double-click the mouse button.

Using Correction Tools

You can use HotShots’ correction tools to eliminate two 
common photographic flaws:

◗ Red Eye Reduction reduces the red effect of the camera’s 
flash on your subject’s eyes

◗ Dust Removal erases blemishes, such as scratches and 
specks from your images

Tool Shape Options

Square Keep it a square

Circle Keep it a circle

Equilateral polygon Number of sides (3 to 9)

Freeform polygon None



Editing Images  7-23

A

B

To delete any changes you make with these tools, select 
Undo from the Edit menu. You can repeatedly select Undo 
to reverse multiple edits (Windows only), or select Redo to 
replace the changes you undid. To delete all the changes 
made since you last saved the picture, select Revert from the 
File menu.

Red Eye Reduction

Follow these steps to replace the red in your subject’s eyes 
with black:

1 Click the Zoom tool and enlarge your image view 
until you can clearly see the pixels in the area you need 
to fix.

2 Click the Red Eye Reduction tool. 

3 Choose the line weight and solidity of the red eye 
correction line with the line attribute options. Select the 
weight of line from either the diffused line or solid line 
row.

4 Move the cursor to the area in your picture you want to 
correct; the cursor is a paintbrush with an eye over it. 
Click and release the mouse button on each affected 
pixel to change it from red to black.

NOTE
If the red eye effect encompasses a large area of the eye, you 
may want to use the Paint Brush tool to replace the original eye 
color instead of correcting it to black with the Red Eye Reduction 
tool. See page 7-17 for instructions on using the Paint Brush tool.

Dust Removal

To subtly erase blemishes in your picture, click the Dust 
Removal tool. Then follow these steps:

1 Choose the line weight and solidity of the dust removal 
line with the line attribute options, shown to the left. 
Select the weight of line from either the diffused line or 
solid line row.

2 Move the cursor to the area in your picture you want to 
correct; the cursor is an eraser (Windows) or a paint 
brush (Macintosh). To erase any blemishes, repeatedly 
click the mouse, or click and drag it, over the blemished 
area.

diffused line

solid line

line weight
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Adding Text

To add text to your picture, click the Text tool. Then 
follow these steps:

1 Click and drag the mouse over the area where you want 
to place a text box and type your text in the box. 

2 Now click on the text box border; the border becomes 
striped with control boxes in each corner. 

3 To format all the text in the box, click any of the text 
options you want to use. To select a text color, see the 
instructions on page 7-15.

4 You can resize or reposition your text box by clicking 
and dragging the striped border. 

To edit the text, click inside the text box where you want 
the cursor positioned and add or delete text.

(To delete a text box, select it and press the Delete key 
on your keyboard.)

text box

bold, italic, and underline

left, center, and 
right align

point size

font
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f you want to increase your camera’s picture storage I capacity or keep an extra CompactFlash card on hand, 
you can install these types of CompactFlash cards in your 
PhotoPC 650 camera:

◗ New USB Enabled CompactFlash cards, or

◗ Traditional ATA-compatible CompactFlash cards

If you transfer pictures via the Lexar Media JumpShot USB 
cable, you can purchase additional USB Enabled 
CompactFlash cards from Lexar Media. Your camera comes 
with an 8MB USB CompactFlash card, but you can obtain a 
higher capacity card, such as a 16MB, 32MB, 48MB, or 
64MB card.

NOTE
If you need an optional replacement JumpShot USB cable or 
additional USB Enabled CompactFlash cards, contact Lexar 
Media at (800) 789-9418.

8   

If you transfer pictures via the serial cable, you can purchase 
either USB-enabled or ATA-compatible cards for your 
camera. If your computer has a Type II PCMCIA card slot, 
you can also transfer your pictures using an optional 
PCMCIA CompactFlash card adapter, as described in this 
chapter. 

CompactFlash cards and PCMCIA adapters should be 
available where you bought your PhotoPC 650 camera. For 
ATA-compatible CompactFlash cards, EPSON recommends 
cards and PCMCIA adapters from the following 
manufacturers:

◗ Lexar Media, (800) 789-9418

◗ SanDisk, (408) 542-0595

If you need to remove your standard USB Enabled 
CompactFlash card to install a different card, follow the steps 
on the next page.

Using CompactFlash Card Options
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For instructions on installing and using your USB 
CompactFlash card, see the following pages:

◗ To install the card, see page 1-2.

◗ To format the card, see page 1-7.

◗ To transfer pictures from the card to your computer via 
the JumpShot USB cable, see page 4-1.

To format and transfer pictures with an ATA-compatible 
CompactFlash card, follow the instructions beginning on 
page 8-3.

Removing a CompactFlash Card

CAUTION
Never remove the card while the camera is accessing it. Data in 
the card will likely be lost or damaged. Avoid using or storing the 
card in direct sunlight or in dusty, hot, or humid places.

1 Make sure the camera and the LCD monitor are turned 
off. 

2 Open the card and port cover on the side of the camera. 
Then slide the Eject Card switch on the bottom of the 
camera to eject the card, as shown below. 

3 Remove the card, then close the card and port cover.
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Formatting an ATA-Compatible 

CompactFlash Card

You should format your ATA-compatible CompactFlash 
card before using it. You may need to reformat it later if a 
message appears on the LCD monitor instructing you to do 
so. With the card installed in the camera, follow these steps:

1 Set the monitor switch to PLAYBACK. If the card is 
new, No Pictures displays on the LCD monitor.

2 Press the SELECT button to display the LCD monitor 
menus.

3 Press the  or  button until you see the Photo 
Control menu. Then press the SELECT button to 
display the menu options, as shown below:

4 Press the  or  button until Reformat is 
highlighted. Press the SELECT button. A message 
appears asking you to confirm the erasure of data. 

5 Press the SELECT button again to format the card and 
return to the Photo Control menu.

6 Press BACK until you return to normal playback mode.

NOTE
If you have problems formatting or using a CompactFlash card, 
contact the manufacturer for technical support. See page 9-10 for 
instructions on contacting Lexar Media. For SanDisk cards, call 
(408) 542-0400.

Transferring Pictures with a PCMCIA 

Adapter

A PCMCIA adapter allows you to transfer pictures stored on 
a USB-enabled or ATA-compatible CompactFlash card 
directly to your computer or laptop. To use this adapter, 
your computer must be equipped with a Type II PCMCIA 
card slot.

If you’re using a Macintosh, you must enable the PC 
Exchange extension software to access files on ATA-
compatible CompactFlash cards. See your Macintosh 
documentation for more information.

Photo Control

Erase 

Lock

Reformat
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NOTE
If you don’t have a PCMCIA adapter, you can still transfer pictures 
to your computer using the serial cable (see page 4-9) or USB 
adapter (for USB cards only; see page 4-1).

Follow these steps to transfer pictures with a PCMCIA 
adapter: 

1 Remove the CompactFlash card from your camera, as 
described on page 8-2.

2 Insert the card all 
the way into the 
adapter.

3 Insert the adapter 
with the 
CompactFlash card 
into your computer’s 
Type II PCMCIA 
slot:

4 Once the adapter and card are installed in your 
computer’s PCMCIA slot, you can transfer photos by 
simply copying them to your hard drive. The image files 
are stored in the Photo650 folder on the card.

◗ In Windows, use My Computer or the Windows 
Explorer to drag and drop image files to your hard 
drive. See your Windows documentation for 
instructions.

◗ On a Macintosh, use the Finder to drag and drop 
image files to your desktop or hard drive. See your 
Macintosh documentation for instructions.

NOTE
If you can’t access a card in your notebook computer, contact the 
computer manufacturer. Also try the troubleshooting procedure 
on page 9-6.

PCMCIA adapter
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Maintenance and Troubleshooting

.

our PhotoPC 650 camera is easy to take care of, andYany problems you may have are easy to solve. This 
chapter includes the following sections:

◗ Caring for the camera

◗ Solving camera problems

◗ Solving picture problems

◗ Where to get help 

Caring for the Camera

Before you perform any maintenance procedures on your 
PhotoPC 650, be sure to read the safety instructions in the 
Introduction. Then follow the guidelines here.

9   

Cleaning the Camera

◗ Use a clean, dry cloth to wipe the camera free of dust.

◗ Don’t use harsh or abrasive cleaners. Don’t use liquid or 
aerosol cleaners.

◗ To clean the lens, first blow off any loose dust or dirt. 
Then breathe on the lens and wipe off all moisture with 
a soft, lint-free cloth or lens cleaning tissue. To avoid 
scratching the lens, don’t press too hard.

◗ If necessary, clean the battery contacts with a dry cloth.

◗ If the LCD monitor gets fingerprints or smudges on it, 
use a soft, damp cloth to lightly wipe the monitor. 
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Storing the Camera

◗ Keep the lens covered (power turned off) and store the 
camera in a carrying case or bag when you’re not 
using it. 

◗ When the camera is not used for long periods of time, 
remove the batteries and store them at a low temperature 
in a dry location. This prevents camera damage from 
battery leaks or corrosion.

Do not store the camera in the following locations:

◗ Where it will be exposed to direct sunlight—for 
example, on a car dashboard

◗ Near bright sources of light or high humidity

◗ Near heat sources or in a closed car or trunk

◗ In areas of excessive dirt or dust

◗ Where it will be exposed to strong vibrations or 
magnetic fields

Solving Camera Problems

Check for your problem and possible solutions on the 
following pages.

The camera has no power.

◗ Make sure the lens cover is open all the way.

◗ The camera may have shut off automatically. Press the 
SELECT or BACK button on the back of the camera or 
close and open the lens cover to turn the power back on.

◗ Check the batteries and make sure they are installed 
correctly and that the battery cover is closed securely. If 
that doesn’t work, replace the batteries.

◗ If you’re using the AC adapter, make sure it is securely 
connected to the camera and to a working outlet.

You can’t take a picture with the camera.

◗ The flash may be recharging. Wait until the status light 
turns green and try again.

◗ Check the picture capacity on the status display panel. 
Erase some pictures (see Chapter 3), or transfer them to 
your computer and then erase them (see Chapter 4). 
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◗ You may need to format or eject your CompactFlash 
card. Check to see if a message is displayed on the 
camera’s LCD monitor.

◗ When the camera is connected to your computer with 
the serial cable, you can’t use the camera’s controls. 

The flash doesn’t work.

◗ Make sure the flash is not set to the flash off setting.

◗ Check your battery power on the status display panel 
and make sure they are installed correctly. Replace the 
batteries if necessary.

Your LCD monitor flickers.

◗ Check the lights around you. The monitor may appear 
to flicker under fluorescent light. This does not affect 
your picture quality.

Your LCD monitor image is speckled or “noisy”

◗ In low light conditions, there may be insufficient light 
reaching the camera’s sensor. This won’t affect the 
quality of your picture unless you turn the flash off. 
Make sure you use a flash mode (see page 2-11).

Nothing appears on the LCD monitor.

◗ If you’re using View mode, make sure the power is on.

◗ Check your batteries and make sure they are installed 
correctly. Replace the batteries if necessary.

The image on the monitor is too dark or light.

◗ Adjust the brightness of the monitor using the Settings 
menu. See page 3-14 for instructions.

A white or light-colored band appears on the monitor 
image.

◗ This happens when you’re facing a brightly lit subject, 
and won’t affect your picture quality.

Nothing appears on the television when you connect your 
camera to it.

◗ Make sure you set the camera’s Video setting to the 
correct standard for your area. See page 3-11 for details.

◗ Make sure the video cable is connected correctly and the 
camera and TV are turned on. See page 3-11 for details.

◗ Make sure your LCD monitor is set to PLAYBACK.

◗ Make sure the TV is set to video mode. See the manual 
for your television if you need help.
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◗ Check your batteries and make sure they are installed 
correctly. Replace the batteries if necessary.

◗ If you’re using the AC adapter, make sure it is securely 
connected to the camera and to a working outlet.

The “pictures remaining” number on the status display 
panel doesn’t decrease after you take a picture.

◗ Your camera is operating correctly. The total number of 
pictures you can store depends on your pictures’ 
content. So the number doesn’t always change, 
especially when you’re using standard image quality.

You get an error message when you try to transfer your 
pictures to the computer.

◗ Make sure the JumpShot USB or serial cable is 
connected correctly, as described in Chapter 4.

◗ If you’re trying to transfer pictures via the JumpShot 
USB cable and your computer doesn’t recognize the 
USB CompactFlash card, try the following:

1 Make sure you installed the USB card and cable 
drivers, as described in Chapter 1 (Macintosh) or 
Chapter 4 (Windows 98). 

2 Try disconnecting, and then reconnecting, the USB 
cable while the card is inserted. 

3 Make sure the card is fully inserted into its slot in 
the USB cable. Also make sure the card is a Lexar 
Media USB CompactFlash card; you can’t use any 
other type of card with the JumpShot USB cable.

4 If you’re using a USB hub port, or a USB port on 
the keyboard or monitor of an iMac or Power 
Macintosh G3, connect the USB cable directly to a 
USB port on the system instead.

◗ Make sure your camera’s batteries have enough power or 
connect the AC adapter.

◗ If you’re using a Macintosh and the camera is sharing a 
serial port with another device, turn AppleTalk off. 

◗ If you’re transferring pictures via the serial cable, check 
the serial port settings in the EPSON PhotoPC 650 
TWAIN or Plug-In software. You may need to change 
the Port setting to Auto Detect and change the Speed. 
See page 4-23 for instructions.
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◗ If you’re using a Windows system and have trouble 
connecting to the COM port, check the computer’s 
COM port settings. Make sure the port is properly 
configured and that the Base I/O port address and the 
Interrupt Request Number (IRQ) assigned to the port 
are not in conflict with any other devices. Also check the 
port setting in your Windows Control panel. You may 
need to set your port to a faster speed or lower the FIFO 
buffer size (advanced serial port configuration).

◗ If you see a low memory error message when transferring 
pictures via the serial cable, close the EPSON 
PhotoPC 650 TWAIN or Plug-In window and use the 
Save to Folder method to transfer your pictures 
instead. See page 4-15 for instructions. (You may also 
need to close and then reopen your application software 
to free-up your computer’s memory.)

You are unable to drag and drop photos into a document.

◗ If your system has less than 16MB RAM, you may not 
be able to use drag and drop. Make sure you don’t run 
too many applications at the same time. You may need 
to add memory to your system or use another method of 
getting photos into your documents.

◗ Your application may not support drag and drop.

You are unable to copy and paste or import your photo into 
a document on your Macintosh. 

◗ Try increasing your virtual memory using the Memory 
Control Panel. Also increase the memory allocation for 
your word processor or other application. (Select the 
application and choose Get Info from the File menu.)

◗ Try turning off any unnecessary extensions. See your 
Macintosh documentation for more information.

The pictures transfer to your computer too slowly.

◗ The fastest way to transfer your pictures is via the 
JumpShot USB cable. If you must use the serial cable, 
use the Save to Folder method instead of transferring 
the pictures into your applications. See Chapter 4 for 
instructions.

◗ If you’re transferring via the serial cable, make sure you 
selected a fast transfer rate in the EPSON PhotoPC 650 
TWAIN or Plug-In software. Click the Setup tab and 
change the speed setting to 115230 (for Windows) or 
230400 (for Macintosh). If your system won’t support 
these faster speeds, select the next lower speed.
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◗ If your system has less than 16MB RAM, the transfer 
speed may be slow. Try using virtual memory. See your 
computer documentation or system help for more 
information.

◗ If you’re transferring pictures via the serial cable, check 
the port speed setting in your Windows Control panel. 
See your Windows documentation or help system for 
more information.

Your system hangs or crashes when you disconnect the 
JumpShot USB cable or remove the USB CompactFlash 
card from it.

◗ Always close the PhotoPC650 folder, exit any open 
applications, and (in Windows) select Eject in Explorer 
before disconnecting the USB cable or removing the 
card from the cable. On a Macintosh, be sure to drag the 
card icon into the Trash folder first—don’t use the 
Eject command in the Special menu. See page 4-6 
(Windows) or page 4-8 (Macintosh) for instructions.

TIP
If you’re using the JumpShot USB cable to transfer pictures, it’s a 
good idea to check Lexar Media’s web site periodically for 
possible updates to your USB CompactFlash card and JumpShot 
USB cable drivers. Access www.lexarmedia.com for details.

Your notebook computer can’t access an ATA-compatible 
CompactFlash card inserted with a PCMCIA adapter.

◗ If you’re using an IBM Thinkpad,™ call IBM for 
technical support or follow these steps to download and 
install an updated driver from IBM: 

1 Download the files from ftp://ftp.pc.ibm.com/pub/
pccbbs/mobiles/yptf$049.exe and unzip them to a 
blank 1.44MB diskette.

2 Make sure your PC Card driver says PCIC or 
compatible PCMCIA controller on IBM 
System in the Control Panel/System/Device 
Manager. Then select Update Driver/Have Disk 
and refer the system to A: for all missing files. 

If your PC Card driver says PCIC or compatible 
PCMCIA controller, go to Update Driver in the 
Device Manager and select PCIC or compatible 
PCMCIA controller on IBM System. 

3 Insert the CompactFlash card with a PCMCIA 
adapter. The system should prompt for a driver. 
Select OK to use the Windows default ESDI/IDE 
HDD Controller driver. A folder appears on the 
desktop with a drive letter assigned to the card. 
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Solving Picture Problems

If you’re not satisfied with some of the pictures you get from 
the PhotoPC 650, you may need to adjust some of the 
camera settings. Read the suggestions in this section.

Your pictures display poor image quality on your computer 
monitor or when you print them out.

◗ PhotoPC 650 captures images in 24-bit color 
(16.7 million colors). Your pictures will not display 
maximum image quality if your monitor or computer’s 
video controller doesn’t support this color depth. You 
may need to upgrade your system to achieve the best 
possible image quality.

◗ If your pictures look better on the screen than when you 
print them out, you may need to upgrade your printer. 
An EPSON color ink jet printer, for example, provides 
excellent image quality.

◗ If you used drag and drop to insert your pictures, they 
may appear grainy. Try importing them into your 
documents instead.

The colors in your picture have a yellow or green color cast.

◗ When you take pictures under certain artificial lighting 
conditions—such as fluorescent, incandescent, or 
halogen lighting—the colors in your image may take on 
a yellow or green cast. You can use HotShots to touch-
up the colors; see Chapter 7 for instructions.

Your picture is blurry or out of focus.

◗ Make sure your subject is within the camera’s range. You 
should be at least 12 inches away to take a picture 
without the flash, and 3.2 feet away to take a picture 
with the flash. You can take a picture as close as 6 inches 
in macro mode.

◗ When you focus on a nearby object, the picture’s 
background may appear blurry. Try changing the focus.

◗ When you take macro close-ups, make sure you have 
adequate lighting (with the flash disabled). Using a 
tripod will help you capture sharp pictures.

◗ Make sure you hold the camera steady after you press 
the shutter button (until the red light starts to flash), and 
your subject isn’t moving.

◗ Make sure your flash is not set to flash off.
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Your picture is too dark (underexposed).

◗ You may need to use the flash. Make sure the setting is 
not flash off.

◗ If you’re using the flash, make sure your subject is 
between 3.2 and 9.8 feet away. 

◗ Use HotShots to adjust the picture’s brightness and 
contrast as described Chapter 7.

◗ If you’re using the macro mode to take a close-up 
photo, be sure to provide adequate lighting for your 
subject, since the camera’s smallest aperture setting is 
automatically selected in this mode.

Your picture is too light (overexposed).

◗ If you’re using the forced flash setting, it may be too 
bright. Try setting the flash to Auto.

◗ If you’re facing a bright light source, you may need to 
shoot your picture from a different angle.

◗ Use HotShots to adjust the picture’s brightness as 
described in Chapter 7.

Part of your picture is missing.

◗ Make sure you’re not blocking the lens with your finger, 
hand strap, clothing, or other object.

A horizontal or vertical red line appears on your picture.

◗ Red lines are caused by glare. Avoid photographing 
shiny surfaces that reflect excessive amounts of light into 
your lens. 

Your pictures don’t look as good as they used to.

◗ Your camera’s lens may be dirty or dusty. Try cleaning it 
by following the instructions on page 9-1.

The area captured in the photo is different from what you 
saw in the viewfinder.

◗ Make sure you look straight through the viewfinder. 
Keep in mind that the area visible through the 
viewfinder is slightly smaller than the area captured in 
the photo.

◗ If you’re taking a close-up or macro mode picture, use 
the LCD monitor.
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Where To Get Help

If you’ve tried the on-screen help and checked this User’s 
Guide but you still have questions, EPSON provides 
technical assistance through electronic support services and 
automated telephone services 24 hours a day, as follows: 

To speak to a technical support representative, dial 
(310) 974-1983 (U.S.), or (905) 709-3839 (Canada), 6 AM 
to 6 PM, Pacific Time, Monday through Friday. Toll or long 
distance charges may apply.

Before you call, please have the following information ready:

◗ Product name (EPSON PhotoPC 650)

◗ Product serial number (located on the bottom)

◗ Computer configuration

◗ Description of the problem

You can purchase manuals and accessories from EPSON 
Accessories at (800) 873-7766 or visit our web site at 
www.epsonsupplies.com (U.S. sales only). In Canada, please 
call (800) 873-7766 for dealer referral.

Electronic support services

Service Access

World Wide Web From the Internet, you can reach EPSON’s Home Page at 
http://www.epson.com.

EPSON Internet 
FTP Site

If you have Internet FTP capability, use your Web browser 
(or other software for FTP downloading) to log onto 
ftp.epson.com with the user name anonymous and your 
e-mail address as the password.

EPSON Forum 
on CompuServe® 

Members of CompuServe can type GO EPSON at the menu 
prompt to reach the Epson America Forum. For a free 
introductory CompuServe membership, call (800) 848-8199 
and ask for representative #529.

Automated telephone services

Service Access

EPSON 
SoundAdvice

For pre-recorded answers to commonly asked questions 
about EPSON products 24 hours a day, seven days a week, 
call (800) 922-8911.

EPSON 
FaxAdvice™

Access EPSON’s technical information library by calling 
(800) 922-8911. You must provide a return fax number to 
use this service.

EPSON Referral 
Service

For the location of your nearest Authorized EPSON 
Reseller call (800) 922-8911.

SM
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Software, CompactFlash Card, and 

JumpShot USB Cable Support

If you’ve tried the on-screen help and checked this User’s 
Guide but you still have questions, contact the following for 
technical support:

◗ For EPSON PhotoPC 650 TWAIN or the Plug-In 
driver, contact EPSON as described in the previous 
section.

◗ For the Lexar Media USB CompactFlash card and 
JumpShot USB cable, contact Lexar Media as described 
below:

◗ For the HotShots software, contact PictureWorks as 
described in the table below. After registering HotShots, 
you have 30 days free technical support via World Wide 
Web, e-mail, and phone. After 30 days, web and e-mail 
support is available.

NOTE
If you wish to install HotShots and/or the EPSON PhotoPC 650 
TWAIN or Plug-In driver on multiple computers, please contact 
PictureWorks as described above for licensing requirements.

Service Access

World Wide Web Visit www.lexarmedia.com for answers to 
frequently asked questions and for possible updates 
to the USB CompactFlash card or Jumpshot USB 
cable drivers

E-mail support@lexarmedia.com

Fax (510) 440-3499

Telephone (510) 413-1200

Service Access

World Wide Web Visit www.pictureworks.com for answers to 
frequently asked questions

E-mail techsupport@pictureworks.com 

Telephone To speak with a technical support representative (in 
English), dial (925) 855-2009
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ou can use the PhotoPC 650 with a variety of options.YTo save battery power, you can use the AC adapter. You 
can also get an EPSON NiMH Power Pak for convenient, 
cost-saving battery power. 

The AC adapter should be available where you bought your 
PhotoPC 650. You can also order it from EPSON 
Accessories at (800) 873-7766 or visit our website at 
www.epsonsupplies.com (U.S. sales only). In Canada, call 
(800) 873-7766 for dealer referral.

EPSON accessory Product code

PhotoPC 650 AC Adapter B867038

Universal NiMH Power Pak with four rechargeable 
batteries and universal charger 

B818172

NiMH Power Pak with four rechargeable batteries 
and 110V charger

B818051

Replacement or additional NiMH rechargeable 
batteries for the NiMH Power Pak

B818061

A   

To increase your camera’s picture storage capacity and add 
flexibility, you can use larger capacity CompactFlash cards 
and PCMCIA adapters, if necessary. (For information on 
using CompactFlash cards, see Chapter 8.) 

Additionally, you can expand the capabilities of your camera 
by attaching standard 37 mm video camcorder lenses and 
filters. You can order optional wide angle, telephoto, and 
close-up lenses and filters from DC PRO: Phone, 
(800) 522-7835 or (516) 434-8800; Fax, (516) 434-9238; 
e-mail, info@dcprodirect.com.

For portraits or studio photographs, you can attach a tripod 
to your camera.

This chapter includes the following instructions:

◗ Using the AC adapter

◗ Using a tripod

◗ Using optional lenses

Using Optional Camera Accessories
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Using the Optional AC Adapter

Using the optional PhotoPC 650 AC adapter (B867038) is 
highly recommended for saving battery power when you 
transfer your pictures via the serial cable. 

The AC adapter allows you to connect your PhotoPC 650 to 
any standard 110V electrical outlet. The adapter powers the 
camera but does not charge the batteries.

WARNING
Use only the adapter designed for the PhotoPC 650. Using any 
other adapter may cause fire, electrical shock, or injury.

Do not alter the plug on the power cable, and do not use the 
adapter for any other purpose than powering your PhotoPC 650.

To ensure the best performance, make sure the AC adapter is 
fully plugged into the camera.

Follow these steps to connect the AC adapter:

1 To avoid losing any images or settings, make sure the 
camera is finished processing. Then turn off the camera. 

2 Open the connector cover on the side of the camera and 
plug the adapter cable into the DC port.

3 Plug the AC adapter into an electrical outlet.
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Using an Optional Tripod

You can use your PhotoPC 650 with any standard tripod. 
Follow these steps:

1 Assemble and set up the tripod by following the 
manufacturer’s instructions. Make sure the tripod is 
well-balanced on a flat surface.

2 Find the threads for the tripod screw on the bottom of 
your camera. 

3 Carefully place the camera on the tripod, then screw it 
on until it is firmly in place. Adjust the tripod to view 
your subject as desired.

Using Optional Lenses

The built-in 37 mm threads on your camera let you attach 
wide-angle, telephoto, and other types of 37 mm video 
camcorder lenses and filters. 

The following table shows the minimum distance from the 
subject, the diagonal angle of view, and the millimeter 
equivalents for wide-angle, close-up, and telephoto lenses 
from Tiffen:

NOTE
For the best results, use lenses that screw directly onto the 
camera, not the type that clip on with tabs.

To attach a lens, simply twist it onto the 37 mm threads in 
the front of your camera, as shown in the next sections.

tripod threads Lens type Nearest subject
Diagonal angle 

of view
Equivalent lens

Standard 20 in. 45° 36 mm

Telephoto 7.5 ft 30° 76 mm

Wide angle (0.65X) 1.5 ft 65° 22.5 mm

+7 diopter close-up 2.5 in. — —

+10 diopter close-up 1.5 in. — —
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You’ll need to use the LCD monitor to take pictures, rather 
than the viewfinder. See page 2-6 for instructions.

CAUTION
You should not leave lenses attached for extended periods of 
time. To prevent accidental damage, make sure you always 
remove lenses when you’re finished using them.

Using Wide-angle Lenses

Wide-angle lenses let you capture a larger area in your 
pictures even when you can’t move further away from the 
subject. Group shots, room interiors, houses or buildings 
with surrounding landscape, and accident scenes are some 
common applications for wide-angle lenses.

Before you start, turn on the camera and set the LCD 
monitor switch to VIEW. Then twist the lens clockwise into 
the threads on the front of the camera.

EPSON

EPSON
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Images captured with a wide-angle lens may be slightly 
distorted in the foreground, and vignetted at the corners, as 
shown in the example below. You can crop the dark corners 
out of your pictures using HotShots, if you want.

NOTE
If necessary, you can use a neutral density filter, contrast 
enhancement filter, or close-up lens with a wide-angle lens. First 
screw the filter or close-up lens onto the camera, then attach the 
wide-angle lens.

Using Telephoto Lenses

A telephoto lens lets you capture details in the distance, even 
when you can’t get closer to your subject. The subject in 
your picture appears approximately 25% larger than without 
the lens. Common uses for telephoto lenses include portraits, 
architectural details, and surveillance.

To use a telephoto lens, first turn on the camera and set the 
LCD monitor switch to VIEW. Then twist the lens 
clockwise into the threads on the front of the camera.

EPSON

EPSON
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Images captured with a telephoto lens are vignetted at the 
corners, as shown in the example below. Using HotShots, 
you can crop the dark corners out of your pictures if you 
want.

NOTE
As with the wide-angle lens, you can use a neutral density filter, 
contrast enhancement filter, or close-up lens with a telephoto 
lens. First screw the filter or close-up lens onto the camera, then 
attach the telephoto lens. 

Using Close-up Lenses

Although the macro mode on your camera lets you take 
pictures from as close as 5.9 inches, you can use optional 
lenses to get even closer. For example, a +10 diopter lens lets 
you shoot from 1.5 inches, as shown in the table on 
page A-3.

To use a close-up lens, first turn on the camera and set the 
LCD monitor switch to VIEW. Then twist the lens clockwise 
into the threads on the front of the camera until it stops. 

EPSON

EPSON
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Camera

Physical Dimensions

Safety Specifications

Width 5.3 inches (134.5 mm) 

Height 2.2 inches (57 mm)

Depth 2.8 inches (72 mm)

Weight 11.1 oz, ± 0.4 oz (315 g, ± 10 g), 
without batteries

Conforms to FCC specifications.
FCC Declaration of Conformity on file.

B   

Power Sources

Environmental

Includes 4 AA alkaline batteries. Also accepts lithium or 
rechargeable NiCad or NiMH batteries. 

Optional AC adapter (B867038)

Optional rechargeable NiMH Power Pak with charger and four 
batteries; universal voltage (B818172) or 110 V (B818051

Temperature Operating: 32 to 104 °F (0 to 40 °C)
Storage: –4 to 140 °F 

(–20 to 60 °C)

Humidity
(non-condensing)

Operating: 30 to 90% 
Storage: 10 to 90% 

Specifications
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Technical

Product type 1.09 megapixel CCD (charged coupled 
device), still frame, auto focus camera

Image quality 
modes (pixels)

Uncompressed JPEG: 1152 × 864 
Superfine: 1152 × 864 (low compression)
Fine: 1152 × 864 (medium compression)
Standard: 640 × 480 (VGA)

File format JPEG

Color modes 16.7 million colors or 24-bit

Lens type Five elements in four groups, aspherical 
glass lens

CCD sensor 1/3 inch color area (1.09 megapixels)

Serial interface 1 pin RCA type (to camera); 
RS-232 9-pin (to Windows computer);
8-pin mini-DIN (to Macintosh)

Serial 
communication 
speed

Up to 115.2Kbps (Windows) or 
230.4Kbps (Macintosh) with high-speed 
serial port

Storage type ATA-compatible CompactFlash cards, 
USB or non-USB; 8MB USB 
CompactFlash card standard (described 
below)

USB 
CompactFlash 
card

8MB flash memory

Average picture storage capacity:
Standard: 88 (640 × 480 pixels)
Fine: 47 (1152 × 864 pixels)
Superfine: 30 (1152 × 864 pixels)
Uncompressed: 4 (1152 × 864 pixels)

Optional 
expansion 
memory

USB or ATA-compatible CompactFlash 
cards from 4MB to 80MB (available from 
Lexar Media or SanDisk)

Video out NTSC or PAL standard (user-selectable)
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Photographic

Lens EPSON ClearOptics aspherical glass lens,
6 mm focal length (equivalent to a 
39 mm lens on a 35 mm camera)

Auto focus range 11.8 inches (0.3 m) to infinity
5.9 to 23.6 inches (15 to 60 cm) in macro 
mode

LCD monitor 1.8-inch active matrix TFT color LCD; 
280 × 220 resolution; 15 to 18 frames per 
second refresh rate; instant preview and 
playback modes

Sensitivity Equivalent to ISO 140

Exposure control Program auto exposure

White balance Full automatic TTL white balance 
through lens

Shutter Electromechanical shutter, 
1/4 second to 1/500 second speed

Viewfinder Virtual, with edge border (80% accuracy)

Aperture f2, f4, f5.6, f11

Flash modes Automatic, forced flash, red-eye 
reduction flash, or flash off

Flash range 3.2 to 9.8 ft (1 to 3 m)
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Lexar Media JumpShot USB Cable Optional AC Adapter

Physical Dimensions

Technical

Interfaces CompactFlash Type I socket for USB 
CompactFlash card; USB type A 
connector for Windows 98 PC, iMac, or 
Power Macintosh G3

LED indicator Steady green when USB CompactFlash 
card is recognized; flashing green during 
data transfer

Connector 
dimensions

Length: 3 inches (76 mm)
Width: 1.5 inches (38 mm)
Height: 0.7 inch (17.5 mm)

Cable length 2.5 feet (0.8 meters)

Width 1.97 inches (50 mm) 

Height 1.18 inches (30 mm) 
1.85 inches (47 mm) including pins

Depth 3.74 inches (95 mm)

Output DC 7V/2.0A

Input 110 to 120 V AC, 50 to 60 Hz
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A

AC adapter, Intro-3, 1-4, 2-3, A-1 to A-2, B-4
Accessories, Intro-3, A-1 to A-6
Air Brush tool, HotShots, 7-18
Alert beep, setting, 3-12 to 3-13
AppleTalk, 4-11
Attaching hand strap, 1-5
Auto focus, 2-1, 2-4 to 2-6, B-3
Automatic shut-off, 2-2, 2-5, 2-7

B

Batteries
checking, 2-3
installing, 1-3 to 1-5
NiMH, optional, Intro-3
saving power, 2-2
specifications, B-1
storing, 9-2
using, 1-4 to 1-5

Battery icon, 2-3
Beep, setting, 3-12 to 3-13
Brightness setting, LCD, 3-12, 3-14 to 3-15
Brightness, adjusting image, 7-8 to 7-10

C

Cable, JumpShot USB
specifications, B-4
support, 9-10
unpacking, 1-1 to 1-2
using, 4-1 to 4-9, 8-1

Cable, serial, 4-9 to 4-11
Cable, video, 3-11 to 3-12
Camera, see PhotoPC 650 camera
Caring for camera, 9-1 to 9-2
CD-ROM, installing software, 1-8
Charger, battery, optional, Intro-3
Cleaning camera, 9-1
Clock, setting, 1-5 to 1-6, 3-12 to 3-13
Clone tool, HotShots, 7-20 to 7-21

Index
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Close-up lenses, A-3, A-6
Close-up pictures, 2-4, 2-10 to 2-11, 9-7 to 9-8
Collections, HotShots

adding information to, 6-5 to 6-8
adding or deleting pictures in, 6-3 to 6-4
dragging and dropping from, 5-3 to 5-4
opening pictures in, 6-2 to 6-3
organizing pictures in, 6-4 to 6-5
printing, 6-12 to 6-13
slide shows, 6-18 to 6-19

Color correcting, HotShots, 7-6 to 7-10
Colors, selecting, HotShots, 7-15 to 7-16
CompactFlash cards

erasing pictures from, 1-7, 4-9
formatting, 1-7, 8-3
installing, 1-2, 1-6, 4-2 to 4-3
picture storage capacity, Intro-2, 2-8 to 2-9, A-1, B-2
problems, 9-3
specifications, 8-1, B-2
support, 9-10
transferring pictures from, 4-1 to 4-9, 8-3 to 8-4
USB cable, see Cable, Jumpshot USB
using, 8-1 to 8-4

Compression, 2-9
CompuServe, 9-9
Computer, connecting camera to, 4-9 to 4-11

Converting pictures, 5-2
Copying pictures into documents, 5-3, 9-5
Correction tools, HotShots, 7-22 to 7-23
Cropping tool, HotShots, 7-16 to 7-17

D

Date, setting, 1-5 to 1-6, 3-12 to 3-13
Deleting pictures, see Erasing pictures
Dimensions

AC adapter, B-4
camera, B-1
JumpShot USB cable, B-4

Display panel, status, 2-2, 2-8, 9-4
Documents, getting pictures into, 5-1 to 5-4
Downloading pictures, 4-1 to 4-24
Drag and drop, 5-3 to 5-4, 9-5
Drawing Shapes tool, HotShots, 7-22
Drawing tools, HotShots, 7-17 to 7-22
Dust Removal tool, HotShots, 7-22 to 7-23

E

Editing pictures, 7-1 to 7-24
E-mail support, 9-10
Enhancement tools, HotShots, 7-12 to 7-24
Environmental specifications, B-1
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EPSON
Accessories, 9-9, A-1
help, 9-9
TWAIN, see TWAIN, EPSON PhotoPC 650

Erasing pictures
from CompactFlash card, 1-7, 4-9
using Playback Mode, 3-6 to 3-8
using Quick Review, 2-5, 2-7, 2-11 to 2-12

Eyedropper tool, HotShots, 7-16

F

FaxAdvice, EPSON, 9-9
Fill tool, HotShots, 7-18 to 7-19
Filters, A-3 to A-6
Fix By Example, HotShots, 7-8 to 7-10
Flash, 2-11, 9-3, 9-8
Flipping tool, HotShots, 7-2
Focus, auto, 2-1, 2-4 to 2-6, B-3
Formatting CompactFlash cards, 1-7, 8-3

H

Hand strap, attaching, 1-5
Help

card and JumpShot USB cable, 9-10
EPSON, 9-9
software, 9-10

HotShots software
calibrating monitor with, 6-2
collections, see Collections, HotShots
editing pictures in, 7-1 to 7-24
information, adding, 6-5 to 6-8
inserting pictures into documents with, 5-1 to 5-4
installing, 1-8
opening pictures in, 6-2 to 6-4
PictureWorks support, 9-10
printing with, 6-8 to 6-13
renaming pictures in, 6-5
saving pictures in, 6-3, 6-5
Smart Print, 6-11 to 6-12
transferring pictures with, 4-11 to 4-17

I

Image quality
displaying on LCD monitor, 3-5
editing, in software, 7-1 to 7-24
problems, 9-7 to 9-8
setting, camera, 2-8 to 2-9

Importing pictures into documents, 5-1 to 5-3, 9-5
Information

in HotShots, 6-5 to 6-8
setting, camera, 3-2, 3-5
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Installing
batteries, 1-3 to 1-5
software, 1-8

Internet, 9-9 to 9-10

J

JPEG files, 2-9, 5-2
JumpShot USB cable, see Cable, JumpShot USB

L

Language, setting, 3-3, 3-15
LCD monitor

brightness setting, 2-6, 3-12, 3-14 to 3-15
cleaning, 9-1
menus, 3-2 to 3-15
playing back pictures on, 3-1 to 3-10
problems, 9-3
specifications, B-3
taking pictures with, 2-6 to 2-7, 2-10 to 2-11, 

A-4 to A-6
Lens, cleaning, 9-1
Lenses, optional, A-1, A-3 to A-6
Lexar Media, 1-7, 8-1, 8-3, 9-10
Line tool, HotShots, 7-21
Locking and unlocking pictures, 3-8 to 3-10

M

Macintosh
connecting to camera, 4-9 to 4-11
installing software, 1-8
system requirements, Intro-3

Macro mode, 2-4, 2-10 to 2-11, 9-7 to 9-8
Magic Wand tool, HotShots, 7-15
Maintenance, 9-1 to 9-2
Multiple pictures, playing back, 3-4

N

NiMH batteries, optional, Intro-3
NTSC setting, video, 3-11

O

Optional accessories, A-1 to A-6

P

Paint Brush tool, HotShots, 7-17 to 7-18
Painting tools, HotShots, 7-17 to 7-22
PAL setting, video, 3-11
Pasting pictures into documents, 5-3, 9-5
PC, connecting camera to, 4-9 to 4-10
PCMCIA adapter, 8-1, 8-3 to 8-4, 9-6, A-1
Photo Control settings, 1-7, 3-3, 3-6 to 3-10, 8-3
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Photo Pages, HotShots
creating, 6-13 to 6-15
modifying, 6-15 to 6-17
printing, 6-18
saving, 6-17
using, 6-13 to 6-18

Photographic specifications, B-3
PhotoPC 650 camera

AC adapter, using with, 1-4, 2-3, A-1 to A-2
auto shut-off, 2-2
cleaning, 9-1
connecting to Macintosh, 4-9 to 4-11
connecting to PC, 4-9 to 4-10
date, setting, 1-5 to 1-6, 3-12 to 3-13
display panel, status, 2-2, 2-8, 9-4
features, Intro-2 to Intro-3
language, setting, 3-15
maintaining, 9-1 to 9-2
parts, identifying, 1-9 to 1-10
picture counter, 2-8
plastic, removing protective, 1-5
problems, solving, 4-23 to 4-24, 9-2 to 9-6
specifications, B-1 to B-3
storing, 9-2
time, setting, 1-5 to 1-6, 3-12 to 3-13

PhotoPC 650 camera (continued)
tripod, attaching to, A-3
turning on and off, 2-1 to 2-2
unpacking, 1-1 to 1-2

Physical dimensions, B-1, B-4
Picture counter, 2-8
Pictures

close-up, 2-10 to 2-11
collections of, see Collections, HotShots
converting, 5-2
copying and pasting, 5-3, 9-5
downloading, 4-1 to 4-24
dragging and dropping, 5-3 to 5-4
editing, 7-1 to 7-24
erasing, see Erasing pictures
image quality, see Image quality
importing into documents, 5-1 to 5-3, 9-5
in Photo Pages, see Photo Pages, HotShots
information in HotShots, 6-5 to 6-8
information setting, in camera, 3-2, 3-5
inserting in documents, 5-1 to 5-4
locking and unlocking, 3-8 to 3-10
opening in HotShots, 6-2 to 6-3
playing back, see Playing back pictures
printing, 6-8 to 6-12
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Pictures (continued)
problems, solving, 9-7 to 9-8
renaming in HotShots, 6-5
saving in HotShots, 6-3, 6-5
slide shows, 3-5, 6-18 to 6-19
storage capacity of camera, Intro-2, 2-8 to 2-9, B-2
taking, see Taking pictures
transferring, see Transferring pictures

Plastic, removing protective, 1-5
Playing back pictures

as slide show, 3-5, 6-18 to 6-19
on LCD monitor, 3-1 to 3-10
on TV, 3-11 to 3-12, 9-3

Power
AC adapter, Intro-3, 1-4, 2-3, A-1 to A-2, B-4
battery, see Batteries
camera specifications, B-1
problems, 9-2
saving, 1-4 to 1-5, 2-2

Printing, in HotShots
collections, 6-12 to 6-13
Photo Pages, 6-18
pictures, 6-8 to 6-12
Smart Print, 6-11 to 6-12

Problems
camera, 4-23 to 4-24, 9-2 to 9-6
CompactFlash card, 9-3
PCMCIA adapter, 9-6
picture, 9-7 to 9-8

Q

Quick Fix, HotShots, 7-6
Quick Review

mode setting, 3-12 to 3-14
using, 2-5 to 2-7, 2-10 to 2-12

R

Red eye reduction
flash setting, 2-11
tool, HotShots, 7-22 to 7-23

Referral Service, EPSON, 9-9
Registration, Intro-4
Resizing pictures, 7-4
Resolution, adjusting, 7-5

see also Image quality
Rotating pictures, 7-3
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A

B

S

Safety
instructions, Intro-4 to Intro-5
specifications, B-1

SanDisk, 8-1
Selecting editing area, HotShots, 7-13 to 7-15
Serial cable, 4-9 to 4-11
Service

card and JumpShot USB cable, 9-10
EPSON, 9-9
software, 9-10

Settings menu, 3-2, 3-12 to 3-15
Sharpness, adjusting image, 7-8 to 7-10
Shut-off, automatic, 2-2, 2-5, 2-7
Shutter, using, 2-4 to 2-7, 2-10, 2-12
Slide shows, 3-5, 6-18 to 6-19
Smart Print, HotShots, 6-11 to 6-12
SmartPix, HotShots, 7-6 to 7-8
Smudge tool, HotShots, 7-19 to 7-20
Software

HotShots, see HotShots software
installing, 1-8, 4-4 to 4-5
support, 9-10
TWAIN, see TWAIN, EPSON PhotoPC 650

SoundAdvice, EPSON, 9-9
Special Effects tools, HotShots, 7-10 to 7-12

Specifications, B-1 to B-4
Status display panel, 2-2, 2-8, 9-4
Storing camera, 9-2
Strap, attaching, 1-5
Support

card and Jumpshot USB cable, 9-10
EPSON, 9-9 to 9-10
software, 9-10

System requirements, Intro-3

T

Taking pictures
close-up, 2-4, 2-10 to 2-11, 9-7 to 9-8
getting ready, 2-1 to 2-3
using the flash, 2-11
with the LCD monitor, 2-6 to 2-7, 2-10 to 2-11, 

A-4 to A-6
with the timer, 2-11 to 2-12
with the viewfinder, 2-4 to 2-5, 9-8

Technical specifications, B-2, B-4
Technical support, 9-9 to 9-10
Telephoto lens, A-3, A-5 to A-6
Templates, see Photo Pages, HotShots
Text tool, HotShots, 7-24
Tiffen lenses, A-3 to A-6
Time, setting, 1-5 to 1-6, 3-12 to 3-13
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Timer, 2-11 to 2-12
Transferring pictures

problems with, 4-23 to 4-24, 9-5
using other TWAIN applications, 4-17 to 4-24
via JumpShot USB cable, 4-1 to 4-9
via PCMCIA adapter, 8-3 to 8-4
via serial cable, 4-9 to 4-24

Tripod, 2-11 to 2-12, A-3
Troubleshooting, 9-2 to 9-8
Turning camera on and off, 2-1 to 2-2
TV, playing back pictures on, 3-11 to 3-12, 9-3
TWAIN, EPSON PhotoPC 650

installing, 1-8
support, 9-9
transferring pictures with, 4-11 to 4-24

U

Unlocking pictures, 3-9 to 3-10
Unpacking the camera, 1-1 to 1-2
USB

cable, see Cable, JumpShot USB
Macintosh driver, installing, 1-8
Windows 98 driver, installing, 4-4 to 4-5

V

VCR, playing back pictures, 3-11 to 3-12
Video cable, 3-11 to 3-12
View mode, see LCD monitor
Viewfinder, taking pictures with, 2-4 to 2-5, 9-8

W

Wide-angle lens, A-3 to A-5
Windows

installing software, 1-8, 4-4 to 4-5
system requirements, Intro-3

World Wide Web, 9-9 to 9-10

Z

Zoom tool, HotShots, 7-13
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EPSON AMERICA, INC.
LIMITED WARRANTY

What is Covered: Epson America, Inc. (“EPSON”) warrants to the first end-user 
customer that the EPSON PhotoPC 650 Digital Camera enclosed with this limited 
warranty statement, if purchased and used in the United States or Canada, conforms 
to the manufacturer’s specifications and will be free from defects in workmanship and 
materials for a period of one year from the date of original purchase. 

What EPSON Will Do To Correct Problems: Should your EPSON product prove 
defective during the warranty period, please call EPSON at (310) 974-1983 for 
warranty repair instructions and return authorization, if required. An EPSON service 
technician will provide telephone diagnostic service to determine whether the unit 
requires repair. If repair is required, EPSON will, at its option, repair or replace on an 
exchange basis the defective unit, without charge for parts or labor. If the product 
requires repair or replacement, it is your responsibility to package it in its original 
container or an equivalent, along with proof of the date of original purchase and ship 
it to EPSON. Packaging and shipping costs incurred in presenting your EPSON 
product for warranty service are your responsibility. Return shipping costs from the 
EPSON repair facility are EPSON’s responsibility. When warranty service involves 
the exchange of the product or of a part, the item replaced becomes EPSON 
property. The exchanged product or part may be new or previously repaired to the 
EPSON standard of quality. Exchange or replacement products or parts assume the 
remaining warranty period of the product covered by this limited warranty.

What This Warranty Does Not Cover: This warranty covers only normal consumer 
use in the United States and Canada. This warranty does not cover damage to the 
EPSON product caused by parts or supplies not manufactured, distributed or 
certified by EPSON. This warranty does not cover third party parts, components or 
peripheral devices added to the EPSON product after its shipment from EPSON. 
EPSON is not responsible for warranty service should the EPSON label or logo or the 
rating label or serial number be removed or should the product fail to be properly 
maintained or fail to function properly as a result of misuse, abuse, improper 
installation, neglect, improper shipping, damage caused by disasters such as fire, 
flood, and lightning, improper electrical current, software problems, interaction with 

non-EPSON products, or service other than by an EPSON Authorized Servicer. If a 
claimed defect cannot be identified or reproduced in service, you will be held 
responsible for costs incurred.

THE WARRANTY AND REMEDY PROVIDED ABOVE ARE EXCLUSIVE 
AND IN LIEU OF ALL OTHER EXPRESS OR IMPLIED WARRANTIES 
INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF 
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. SOME 
LAWS DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES. IF 
THESE LAWS APPLY, THEN ALL EXPRESS AND IMPLIED WARRANTIES 
ARE LIMITED TO THE WARRANTY PERIOD IDENTIFIED ABOVE. 
UNLESS STATED HEREIN, ANY STATEMENTS OR REPRESENTATIONS 
MADE BY ANY OTHER PERSON OR FIRM ARE VOID. EXCEPT AS 
PROVIDED IN THIS WRITTEN WARRANTY, NEITHER EPSON AMERICA, 
INC. NOR ITS AFFILIATES SHALL BE LIABLE FOR ANY LOSS, 
INCONVENIENCE, OR DAMAGE, INCLUDING DIRECT, SPECIAL, 
INCIDENTAL OR CONSEQUENTIAL DAMAGES, RESULTING FROM THE 
USE OR INABILITY TO USE THE EPSON PRODUCT, WHETHER 
RESULTING FROM BREACH OF WARRANTY OR ANY OTHER LEGAL 
THEORY.

In Canada, warranties include both warranties and conditions.

Some jurisdictions do not allow limitations on how long an implied warranty lasts 
and some jurisdictions do not allow the exclusion or limitation of incidental or 
consequential damages, so the above limitations and exclusions may not apply to you.

This warranty gives you specific legal rights, and you may also have other rights which 
vary from jurisdiction to jurisdiction.

To locate the EPSON Authorized Reseller nearest you call:

(800) 922-8911
or write to:

Epson America, Inc.  •  P. O. Box 2842  •  Torrance, CA  90509-2842  •  MS: CS1
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FCC COMPLIANCE STATEMENT
FOR AMERICAN USERS

This equipment has been tested and found to comply with the limits for a 
class B digital device, pursuant to Part 15 of the FCC Rules. These limits are 
designed to provide reasonable protection against harmful interference in a 
residential installation. This equipment generates, uses, and can radiate radio 
frequency energy and, if not installed and used in accordance with the 
instructions, may cause harmful interference to radio and television reception. 
However, there is no guarantee that interference will not occur in a particular 
installation. If this equipment does cause interference to radio and television 
reception, which can be determined by turning the equipment off and on, the 
user is encouraged to try to correct the interference by one or more of the 
following measures:

◗ Reorient or relocate the receiving antenna

◗ Increase the separation between the equipment and receiver

◗ Connect the equipment into an outlet on a circuit different from that to 
which the receiver is connected

◗ Consult an experienced radio/TV technician for help.

WARNING
The connection of a non-shielded equipment interface cable to this equipment 
will invalidate the FCC Certification of this device and may cause interference 
levels that exceed the limits established by the FCC for this equipment. It is the 
responsibility of the user to obtain and use a shielded equipment interface cable 
with this device. If this equipment has more than one interface connector, do 
not leave cables connected to unused interfaces.

Changes or modifications not expressly approved by the manufacturer could 
void the user’s authority to operate the equipment.

FOR CANADIAN USERS
This Class B digital apparatus complies with Canadian ICES-003. Cet appareil 
numérique de la classe B est conforme à la norme NMB-003 du Canada.

DECLARATION OF CONFORMITY
According to 47CFR, Part 2 and 15

Declare under sole responsibility that the product identified herein, complies 
with 47CFR, Part 2 and 15 of the FCC rules as a Class B digital device. Each 
product marketed is identical to the representative unit tested and found to be 
compliant with the standards. Records maintained continue to reflect the 
equipment being produced can be expected to be within the variation accepted, 
due to quantity production and testing on a statistical basis as required by 
47CFR 2.909. Operation is subject to the following two conditions: (1) this 
device may not cause harmful interference, and (2) this device must accept any 
interference received, including interference that may cause undesired 
operation.

Representative: EPSON AMERICA, INC.
Address: 20770 Madrona Avenue

MS: B2-11
Torrance, CA 90503

Telephone: (310) 782-5254

Trade Name: EPSON
Type of Product: Digital Camera
Type of Device: Class B Peripheral
Model: PPC650

We hereby declare that the equipment specified above 
conforms to the above Standards.
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